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Chapter 1 NetTune Introduction

NetTune is a product of HawkNet, Inc., a pioneer and leader in network
performance software solutions. NetTune is designed to assist network managers
with the following network tasks:

• Capacity planning

• Troubleshooting

• Monitoring (over 110 NetWare internals)

• Report and analysis

• Network Optimization

Network Internals

NetTune provides network managers with a detailed view of every file server on the
network, offering instant access to both real-time and historical data.

The following statistical report categories are available for instant viewing and
analysis:

• NetWare

• LAN

• Network interface cards

• Connections

• Disk

• Memory

• Volumes

• NetWare Loadable Modules (NLMs)

Each category offers detailed information, enabling the network manager to avoid
searching through multiple software programs or NetWare’s MONITOR.NLM in
order to monitor activity or track down problems.

Trends that negatively impact the network are easily identified. For example, large
NLMs can degrade network performance because of their voracious memory
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requirements. With NetTune, the network manager is able to instantly view and
track memory allocation.

In addition, a server memory map is available along with complete information on
each loaded NLM. This allows the network administrator to quickly determine the
following:

• Version numbers

• Dates

• RAM footprints

• Memory usage

Report Data

NetTune compiles a valuable user-defined historical database for up to 400 days.
Data is accessible in the following formats:

• Standard reports

• User customized reports

In addition, NetTune includes 12 custom graphing and reporting alternatives
including, 2-D, 3-D, Bar, and Gantt charts.

Network Performance Optimization

NetWare SET parameter values significantly affect both server performance, and
how the operating system responds to network requests.

Utilizing NetTune real-time and historical statistical data to track server workloads,
network administrators can improve server performance using one of the following
NetTune options:

• Manually adjust internal NetWare operating system’s SET parameters through
NetTune’s Graphical User Interface.

• Create custom Tune files, and schedule SET parameter changes through those
custom Tune files.

• Have SmartTune automatically adjust server SET parameters on the fly, based
on real-time decision making algorithms.

NetTune runs on the server as a NLM, and on the client as a Windows application.
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NetTune User Interface
This section describes the following components of the NetTune application user
interface:

• The Control Menu Box is used to resize, move, maximize, minimize, close
windows, and switch to other window applications.

• The Window Title Bar displays the title name of the currently active window.

• The Minimize Button reduces the current window to an icon.

• The Restore Button returns the window to its previous size.

• The Menu Bar lists all available pull-down menus for the current window.

• The Tool Bar lists all available tools for the current window.

• The Application Window is the NetTune desktop.

• The Application Icons represent manageable objects on the NetTune desktop.

• The Status Bar displays information on the current menu selection, the currently
highlighted server name, NetWare version, and login name.

Figure 1. 1 - Typical NetTune Application Window

For a detailed review of the Windows interface, refer to your Microsoft Windows

User Guide.
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Menu Commands
Menus on the menu bar are used to display groups of NetTune commands.

Common Menu
Conventions

Description

A dimmed command Command unavailable.

Ellipsis (...) following a
command

A dialog box will appear when
this command is chosen.

A check mark (√ ) next to a
command

Command currently in effect.

A triangle ( ) following a
command

A cascading menu will appear
when this command is chosen.

In the Window menu bar each of the listed commands contains an underlined letter
somewhere within the command name. If the key corresponding to the underlined
letter is pressed while holding down the [Alt] key, the pull-down menu will then be
displayed.

Many commands listed in the cascading menus have key combinations shown to the
right of the command. Sequentially press the two indicated keys to select the
command.
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Dialog Boxes
NetTune uses a dialog box to request or provide information. Select a menu
command followed by an ellipsis (...), and a dialog will appear.

There are several types of dialog box options.

Dialog Box Options Description

Command Push Buttons Initiate immediate action.

Text Boxes Allow text insertion into entry
field.

Selection Boxes Display a list of choices.

Pull-down Selection
Boxes

Display a list of choices.

Radio Buttons Select a mutually exclusive
option.

Check Boxes Select multiple options.
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Figure 1. 2 - Dialog Box Options
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Types of NetTune Icons
An icon is a graphical representation of a manageable NetTune object that can be
selected and opened.

There are six different NetTune Icons:

• The NetTune Program Icon is used to start the program from Windows.

• The other five icons are used to represent active NetTune objects.

NetTune
Program Icon

File Server Icon NCF File Icon

Statistical Report
Icon

Information Text
Icon

Group Icon

Figure 1. 3 - NetTune Icons
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NetTune Program Icon

Double-clicking on the NetTune icon starts the
program on the client side.

File Server Icon

When a file server icon is selected, the server name
will highlight and the menu bar will reflect the
actions that can be performed on that server. The
NetWare version number will appear on the icon.

NCF File Icon

NCF files are read at start-up by the NetWare
operating system. NCF files are accessed by selecting
a server and using the File pull-down menu. NCF
files can be edited and saved. The NCF File Icon
represents a minimized NCF file.

Statistical Report Icons

Statistical reports (either custom or predefined)
show real-time or historical server activity. Once
minimized, these reports are represented by the
Statistical Report Icon.

Information Text Icon

The Information Text Icon represents a minimized
text report based on information located in the
Information pull-down menu. This icon differs from
the statistical report icon that represents historical
information.
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Group Icon

The Group Icon represents a minimized custom group
which contains any file servers associated with that
group.

Files Created by NetTune’s Software

Client Workstation Side

Once NETTUNE.EXE is running, it creates the following two files and places them
in the NetTune directory:

• NETTUNE.INI - NetTune’s initialization file

 This file contains all the Group, Servers, and Desktop preferences and
information.

• NTMENU.INI - NetTune’s menu file

This file contains all the saved custom report names, and will display them in the
Statistics Pull-down menu.

File Server Side

After NETTUNE.NLM is running on a file server, it creates the following three files
and places them in the SYSTEM directory:

• NT$HIST0.NTD - Contains short-term historical and statistical information.

• NT$HIST1.NTD - Contains long-term historical and statistical information.

• NT$INIT.NTD - Contains the interval and duration times that are used by
NT$HIST0.NTD and NT$HIST1.NTD.
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After SMARTUNE.NLM is running on a file server, it creates the following three files
and places them in the SYSTEM directory:

• NT$TT.NTD - Contains scheduled Timed Tune job information.

• NT$ST.NTD - Contains all of the SmartTune options.

• NT$LOG.NTD - Contains a history of the changes made to the set parameters
and other activities on the server.

Reference and Support Documentation
The following publications contain additional information related to NetTune theory
of operation:

• Microsoft Windows User Guide

• Novell NetWare Version 3.11 Concepts Manual

• Novell NetWare Version 3.11 System Administration Manual

• Novell Support Encyclopedia on CD-ROM
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Chapter 2 Installation

Installing NetTune Software on the Client Side

About the Workstation Install

NetTune’s install program (SETUP.EXE) will install 18 files on the client side.
Following is a list of directories that are created during the install, and the files
placed into those directories.

Seven files are placed in the NETTUNE directory (NETTUNE will be the default
directory if one is not specified during the install).

The NetTune files installed to the NETTUNE directory are:
• NETTUNE.EXE - The workstation application program. This file is placed in the

directory you define during the install.

• NETTUNE.HLP - NetTune’s help file.

• WIZARD.HLP - This is the help file for the NetTune Advisor

• NET31X.NLM - NetWare 3.1X data collection module.

• NETTUNE.NLM - Contains the engine for collecting the historical database
information.

• NETCONVRT.NLM - The engine for conversion of database files from the 1.2
format.

• DPATCH.NLM - The disk statistics v1.00 patch contains the Novell fix to
NetWare version 3.11 (only required if running NetWare version 3.11). When
used, it allows statistical disk information to be collected.
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• SMARTUNE.NLM - This NLM contains the engine for performing the
following tasks:

- Manually modifying Set parameters

- Editing NCF Files

- Automatic Tuning

- Scheduling Tune files

• TUNE.NCF - NetWare NCF file used to load the NLMs.

• UNTUNE.NCF - NetWare NCF file used to unload the NLMs.

Eight files are placed in the Windows directory. In our examples, Windows files are
placed in a directory called WINDOWS. If the Windows directory has another name,
the NetTune install program will find it.

NetTune files installed to the WINDOWS directory are:
• GSW.EXE - The NetTune graphics engine for Windows.

• RCONSOLE.PIF - The program information file for RCONSOLE while using
NetTune.

• NWCALLS.DLL - The interface between the Windows application and the
NetWare client code (NETX or VLMs).

• NWIPXSPX.DLL - The interface between the Windows application and the
NetWare client code (the VIPX and IPX).

• METER.DLL - Controls and displays the meter dialog components.

• CTL3DV2.DLL - Gives dialog windows a 3D effect.

• MUSCROLL.DLL - Controls and displays the micro scroll bars dialog
components.

• GSWDLL.DLL - The interface to the graphics engine.
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Getting Started

NOTE:  In our install example the drive letter A: will represent the floppy location
that contains the NetTune setup program. If the B: drive contains the setup program,
replace any mention of A: with B:

To Install the NetTune workstation software:

1. Start Windows

2. From the Program Manager’s menu bar, select the File pull-down menu (Figure
2.4) and choose Run.

Figure 2. 4 - File Pull-Down Menu

3. The Run dialog box will appear (Figure 2.5). Type “A:\SETUP” in the
Command Line field.

Figure 2.5 - Run Dialog Box

4. Next, click on the OK button to accept the path you entered and run the install
program, SETUP.EXE.

After NetTune briefly initializes itself, a setup dialog box will appear (Figure
2.6).
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Figure 2. 6 - NetTune Setup Dialog Box

5. Click on the Continue button to begin the installation.

A destination dialog box will appear (Figure 2.7) that reports the disk space
necessary for installing NetTune and the disk space that is currently available.
The default destination for the NetTune install is also shown.

Figure 2. 7 - Destination Dialog Box
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6. If this default destination is acceptable, click on the Install button and
proceed to Step 7.

If this default destination is not acceptable, change the path by clicking on the
Set Location button. The NetTune Destination path dialog box will appear
(Figure 2.8). When you have typed in the desired NetTune path, click on the
Continue button.

Figure 2. 8 - Destination Path Dialog Box

Once NetTune has a valid destination path it will begin the install process.
During the install process an installation meter will show the percentage of
completed installation (see figure 2.9).

Figure 2. 9 - Installation Meter Dialog Box



24 Using NetTune

7. When SETUP.EXE completes the installation, a Success dialog box will appear
(Figure 2.10).

Figure 2. 10 - Success Dialog Box

When you return to the Windows Program Manager, you will notice a new
group item on the Windows desktop called “Brightworks.” It contains the
NetTune icons.

Figure 2. 11 - HawkNet NetTune Group

NOTE:  Continue to Chapter 3 to setup and run the NLM portion of NetTune
from the Quick Start dialog box.
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Chapter 3 Quick Start Dialog Box

Using the Quick Start
Double-click on the NetTune icon (Figure 3.12) in the HawkNet window.

Figure 3. 12 The NetTune Icon

After a first time install NetTune’s Quick Start dialog box will appear (Figure 3.13)
which presents you with optional, required, and recommended steps for getting
started with NetTune.

After the first install is completed, NetTune’s Quick Start dialog box will not display
again. You can recall the Quick Start dialog by selecting Quick Start from the Help
pull-down menu.
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Figure 3 13 - NetTune Quick Start Dialog Box

NetTune’s Quick Start dialog box contains six options:

• An introduction and overview to NetTune
This step is optional and will load NetTune’s Help index.

• Modify the default recording intervals
This step is optional, and will allow you to modify the default recording
intervals to the NLMs you subsequently install.

• Install NetTune’s NLMs on one or more servers
This is a required step. Without the NLMs installed and loaded, data collection
will not take place.

• Add the newly installed “NetTune” servers to the Desktop
This is a required step. Servers must be added to the desktop or to a group. First
time installers will add their file servers to NetTune’s default group called
Desktop.

• Get a quick review of the servers configuration This step is recommended but
not required. Displayed information on server-related configurations will be
available.

• Exit the Quick Start dialog box

For the remainder of this chapter we will explore the following options:

• Modify the default recording Intervals used by NetTune NLMs

• Installing the NetTune NLMs to a server

• Adding a newly installed server to the desktop

• A quick review of the server’s configuration
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Modifying the Default Recording Intervals  used by
NetTune NLMs

To take full advantage of NetTune it is recommended that you set up the preferred
historical recording intervals before you install the NLM software. Once the NLM
software is installed and loaded, it immediately begins collecting data based on the
NetTune default recording intervals defined at the time of install (see the following
table).

Default Times for Interval and Duration

Interval Duration

Real Time 5 seconds 3 minutes

Short Term 5 seconds 24 hours

Long Term 5 minutes 90 days

If the supplied default values are not sufficient, change to time intervals and
durations that are more appropriate.

The historical recording intervals use two variables to allow NetTune to collect and
record data.

The two user defined variables are Recording Interval and Recording Duration.
• The Recording Interval defines how often NetTune collects (or records) data.

• The Recording Duration specifies the maximum time the data will be kept.
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NetTune’s NLM keeps three historical records of server activity:

NT$HIST0.NTD This file contains short-term recording interval
information. When this file reaches its maximum size
(defined by the Recording Duration), it will purge the
oldest data in the file.

NT$HIST1.NTD This file contains long-term recording interval
information. When this file reaches its maximum size
(defined by the Recording Duration), it will purge the
oldest data in the file.

Real-Time
Memory File

An in-memory file containing the real-time statistics.

To set preferred historical recording intervals:

1. Click on the number 2 button from the Quick Start dialog box (Figure 3.13) to
access and modify the default preferred recording intervals.

2. When the Recording Intervals dialog box appears (Figure 3.14), specify a
time range called the Recording Duration. This defines a specific time period in
which server data will be collected.

Also, specify a collection time called Recording Interval. This defines how often
NetTune’s NLM will collect server data.

Figure 3. 14 - Recording Interval Dialog Box
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The Maximum Size and Current Size fields (found in the Recording Interval dialog
box under Current Recording Interval for Selected Server) are the sizes of the
historical data base files. These files are created when a Recording Interval or
Recording Duration time is supplied for Real-Time, Short Term, or Long Term data
collection (see the following table).

Recording Interval Database File Names

Type of
Statistical
Information

Recording Interval File Name

Real-Time A real-time temporary file in memory

Short Term NT$HIST0.NTD

Long Term NT$HIST1.NTD

The Maximum Size field is shown in bytes. This field is based upon a pre-calculated
file size that is derived from the specified Recording Interval and Recording
Duration times. If you change the Recording Interval or Recording Duration time for
Real-Time, Short, or Long Term data collecting, the Maximum Size field will
automatically recalculate. A new allocated Maximum Size value for that collection
period is then displayed.

The Current Size field is shown in bytes, and is the historical Interval database file’s
current size. The Current Size field tells you how much disk space your current
historical database file is occupying.

To change Recording Interval and Duration default values:

1. Use the scroll bars to scan the selection choices. Once the appropriate times are
established, click on the SET button to save your changes.

2. Click on the Close button when finished.
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The following table shows the maximum and minimum times allowed when
selecting Recording Interval and Recording Duration times.

Maximum and Minimum Times for Recording
Interval and Duration

Interval Duration

Real Time 5-30 seconds 1-10 minutes

Short Term 5-30 seconds 1-48 hours

Long term 1-60 minutes 1-400 days

Installing NetTune’s NLMs to a Server

About the File Server Install

NetTune ships with five NLMs and two NCF files:
• NET31X.NLM - The NetWare 3.1X data collection module.

• NETTUNE.NLM - Contains the engine for collecting the historical database
information.

• DPATCH.NLM - This disk statistics v1.00 patch contains the Novell fix to
NetWare version 3.11 (only required if you are running NetWare version 3.11).
When used, it allows statistical disk information to be collected.

• SMARTUNE.NLM - This NLM contains the engine for performing the
following tasks:

- Manually modifying Set parameters

- Editing NCF Files

- Automatic Tuning

- Scheduling Tune files

• NETCONVRT.NLM - The engine for conversion of database files from the 1.2
format.

• TUNE.NCF - NetWare NCF file used to load the NLMs.

• UNTUNE.NCF - NetWare NCF file used to unload the NLMs.
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Getting Started

Installing the NetTune file server software.

NOTE:  NetTune automatically loads the NLMs into the SYSTEM directory of the
selected file server’s SYS: volume.

1. Click on the number 3 button from NetTune’s Quick Start dialog box (Figure
3.13). This allows you to install NetTune’s NLM to one or more file servers.

2. NetTune’s NLM Install dialog will appear (Figure 3.15).
Under the Show Servers selection box, you will see three options:
• Not Running NetTune - Displays all the file servers that currently do not

have NetTune’s NLM loaded.

• Running an Old Version of NetTune - Displays all the file servers that
currently have an older version NetTune’s NLM loaded.

• ALL - This displays all the file servers without regard to the NetTune
version.

Figure 3. 15 - NetTune NLM Install Dialog Box

Since this is a first time install, select the Not Running NetTune button. A list of
file servers not currently installed with NetTune is displayed in the Server box.

3. Select the file server(s) to be loaded with NLM software and click on the left
mouse button once. The Installation program allows you to make multiple file
server selections.

4. After making a server selection, click on the Install button.

During the NLM install process an installation meter will display the percentage
completed.
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Windows for WorkGroups Note:

If you do not see any file servers listed in the Servers box, Windows for
WorkGroups may not be set up for network use. To select an appropriate
network:

Double click on the network setup icon (from the Network group window).

Next click on the Network button.

A dialog box will appear, select “Install Windows support for the following
network only.”

Next click on the  scroll bar to open the Network selection window.

Now use the scroll bar to select the appropriate NetWare version.

When finished, click the OK button twice to save your settings.

Windows 3.1 Note:

If you do not see any file servers listed in the Servers box, this could mean your
Windows 3.1 is not set up for network use. To select an appropriate network:

Select the Windows Setup icon from the Main window.

Select Change System Settings from the Options pull down menu.

Click on the Networks button and select the appropriate NetWare.

When the NLM installation has been completed, the RCONSOLE request dialog
box will appear (Figure 3.16).

Figure 3. 16 - RCONSOLE Request Dialog Box

5. Click on the Yes button.

Selecting Yes, causes NetTune to automatically load Novell’s RCONSOLE.
This provides you with a user interface for loading NETUNE.

RCONSOLE could fail to load for one of the following reasons:
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• Not having console rights to that file server. Check that you are logged in as
SUPERVISOR or that you have console rights as a user.

• Not enough memory available. Try freeing up some resources to release
additional memory.

• The RCONSOLE.PIF contains the wrong path. Make sure the program
information file has the correct path to RCONSOLE.

6. When the file server prompt appears, load the NetTune module by typing the
following NCF file name:

TUNE

NOTE:  The TUNE.NCF file automatically loads SMARTUNE.NLM in
read/write mode but with timing disabled. To disable the write mode, edit the
TUNE.NCF file and remove the “W” option.

You have now completed Quick Start’s NLM install portion for your file server.

If you installed the NLMs to more than one server, it will be necessary to
connect to each server through RCONSOLE and run the TUNE.NCF file. When
completed, exit RCONSOLE with the <Shift -Esc> key combination.

Additional Notes on the NLM Install

NetTune depends on other NLM’s. When TUNE.NCF is executed at the file server,
dependent NLM’s are automatically loaded. This eliminates the manual loading of
NLMs from the server’s console.

The UNTUNE.NCF file automatically unloads the NLMs in the reverse order that
they were loaded.

To automate the task of loading NetTune, place the load command at the bottom of
your AUTOEXEC.NCF file.
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Adding a Newly Installed Server to the Desktop
NetTune allows you to organize servers into groups which allows you to manage
more servers, while at the same time reducing clutter on the NetTune desktop.

To associate a file server with NetTune’s default group called Desktop:

1. Click on the number 4 button from NetTune’s Quick Start dialog box (Figure
3.13).

2. The Group Management dialog box will appear (Figure 3.17). The NetTune
Server’s box contains a list of servers loaded with NetTune’s NLMs. Highlight
the server you wish to place in the Desktop group by clicking on the file server’s
name.

3. The Add and Add All buttons are now selectable (Figure 3.17). Click on the
Add button to add the selected file server to the Desktop group. To add all the
NetTune servers to the Desktop group, click on the Add All button.

Figure 3. 17 - Selecting a File Server to Add to the Desktop Group

4. After the file server has been added to the Desktop group (Figure 3.18), click on
the Close button to save the selection.

Figure 3. 18 - A File Server Added to the Desktop Group
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For additional information on hiding and showing icons, creating additional
groups, deleting old groups, and renaming groups, see Chapter 12 Group
Management.

A Quick Review of the Server’s Configuration
For a quick review of the server’s configuration, select the number 5 button from the
Quick Start dialog box. Server configuration information is displayed in real-time
and updated at five-second intervals.

From the Server Configuration dialog box (Figure 3.19), select any server. The
following server configuration information is displayed:
• NetWare

• LAN

• Connections

• Volumes

• NLMs

• Set parameters

• NetTune

NOTE:  Only servers running NetTune’s NLM will be visible in the Servers
selection box.

To view a server’s configuration:

• Click on the number 5 button from NetTune’s Quick Start dialog box (Figure
3.13).
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Figure 3. 19 - Server Configuration Dialog Box

The Server Configuration dialog box allows you to select specific file servers for
viewing configuration information.

Selecting items from the Information list box will show configuration information
about that selection.

The Servers selection box (Figure 3.20), located at the bottom left of the Server
Configuration dialog box, displays the Desktop icon representing the group that
contains your file server(s).

Figure 3. 20 - NetTune’s Default Group

The Desktop may contain a single file server or many file servers depending on the
following conditions:

• How many file servers have the NetTune NLM loaded.

• How many of the above-mentioned file servers have been added to the Desktop
group.
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Chapter 4 Using SmartTune

SmartTune Overview
SmartTune’s NLM was designed as an add-on module to enhance NetTune software
and provide a total solution for NetWare optimization.

The Tune pull-down menu provides a choice of three methods for modifying a
server’s SET parameters:
• Manually adjust internal NetWare operating system’s SET parameters through

NetTune’s Graphical User Interface.

• Create custom tune files, and schedule parameter changes through those custom
tune files.

• Have SmartTune automatically adjust server(s) SET parameters on the fly.

In this chapter we will apply these three methods to modify a server’s SET
parameters, with a section for each method. In the case of scheduling Tune files, the
process will include a walk-through on modifying SET parameters.

The method of controlling SET parameters is completely your choice. For additional
information on SmartTune see Chapter 7 Tune Menu Introduction.
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Modifying SET Parameters Manually
The SET Parameters command is used to modify SET parameters or create custom
Tune files (containing SET parameters modifications). Modifications are made
through the SET Parameters dialog box (Figure 4.1).

Figure 4. 1 - SET Parameters Dialog Box

To modify SET parameters manually:

1. Click on Tune pull-down menu from NetTune's menu bar.

2. Select SET Parameters from the Tune pull-down menu.

3. that contains the SET Parameters you wish to modify from the Categories
selection box.

4. Make the change to the SET parameter by scrolling through the selections with
the up and down arrows, or type the desired value into the text window.

5. Click on the Set button to save those parameter changes to the Server’s memory
or NCF files. The SET Parameters Function Successful dialog box will appear.
Click on the OK button.

6. When finished modifying SET parameters, click on the Close button to exit .
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Modifying SET Parameters Through Tune Files

Tune Files and Time Tuning

SmartTune has the ability to schedule pre-defined files, called "Tune" files, to run
(unattended) at specific times. These Tune files contain the SET parameter changes
for the file server's configuration, and they can be identified by an .NTT extension.

The process of scheduling tune files is called, "Time Tuning." Through the SET
Parameters dialog boxes, the administrator can modify any SET parameters in a tune
file, then schedule these parameter changes to automatically run on the server at a
specific time.

This feature allows you to tailor server operation to a specific requirement, such as
evening backup, or database manipulation during the day. The Tune files are created
and stored in the server's SYS:SYSTEM directory, and are used by
SMARTUNE.NLM.

When creating a Tune file, use the custom-graphed historical data to determine
which SET parameters you should alter for maximum optimization.

By maintaining a history of server information during the day, you can chart file
server utilization, thereby identifying the times when the server is handling heavy
traffic or is hardly utilized. Once you have identified the utilization times, you can
start to change the SET parameters for performance optimization.

Tune File Example

Understanding the creation of a Tune file helps to demonstrate its ease of use.

Backing up data on the LAN is a critical task. Administrators are often looking for
ways to enhance backup throughput. Therefore, our example will focus on the issue
of increased performance for backups.

Following is a tuning example everyone can use on their file servers to increase
backup performance. For our example we will assume that the nightly backup begins
at 11:01 p.m. and completes at 5:55 a.m. Additionally, we will assume that the
current server’s SET parameters are NetWare defaults.
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The first step of our tune file example requires you to create two tune files:
• BACKUP.NTT - This file will contain the modified SET parameter changes that

will increase backup throughput. It will be scheduled to run before your backup
begins, and automatically adjusts the SET parameters, causing faster backup
throughput.

• RESET.NTT - This file will contain the default NetWare SET parameters. It will
be used to set the selected file server back to its default configuration after the
backup completes.

The second step of the Tune file project requires you to schedule a Tune Job. Tune
Jobs are the scheduled run times for the Tune files (BACKUP.NTT and
RESET.NTT).

NOTE:  Have your tape Backup software create a log file that contains information
on the amount of data that was backed up, and the elapsed time during backup. This
log file will give you a comparison benchmark for the backup performance
improvement after the parameters have been optimized.

The last step of the tune project requires you to run two backups. The first backup
will be run at night without any changes to the server. This is to log an elapsed time
for the backup without NetTune. The following night run your backup using
NetTune, BACKUP.NTT and RESET.NTT. In the morning compare both elapsed
times from the LOG file to see the improvement in backup time.

Creating the Tune Files

1. Click on the Tune pull-down menu from the NetTune menu bar.

2. Select SET Parameters from the Tune pull-down menu.

3. When the SET Parameters dialog box appears, click on the New button. This
will create a new Tune file.
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5. The New Tune File dialog box will appear (Figure 4.2). Select the Server’s
Current Values radio button.

Figure 4. 2 - New Tune File Dialog Box

6. For the Name field enter BACKUP.NTT (Figure 4.3).

Figure 4. 3 - Naming a New Tune File

7. Click on the OK button.

8. The new Tune file will be listed in the Servers\Tune Files selection box on the
lower left of SET Parameters dialog box. Select BACKUP.NTT by highlighting
the tune file name (Figure 4.4).
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Figure 4. 4 - SET Parameters Dialog Box

8. While the Tune file BACKUP.NTT is highlighted, click on File Caching from
the Categories selection box.

9. When the File Caching dialog box appears (Figure 4.5), change the parameter
Dirty Disk Cache Delay Time to 5.0 seconds.

Figure 4. 5 - SET Parameters File Caching Dialog Box
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10. Next, change the parameter Maximum Concurrent Disk Cache Writes to 25.

NOTE:  Changing this parameter will have no adverse effect on your file server.

11. Click on the Set button to save your changes to the File Caching category. The
SET Parameters Function Successful dialog box will appear (Figure 4.6). Click
on the OK button.

Figure 4. 6 - SET Parameters Function Successful Dialog Box

12. Select Directory Caching from the Categories selection box.

13. When the Directory Caching Parameter dialog box appears (Figure 4.7), change
Dirty Directory Cache Delay Time to 7.0 seconds.

Figure 4. 7 - SET Parameters Directory Caching Dialog Box

14. Click on the Set button to save your changes to the Directory Caching category.
The SET Parameters Function Successful dialog box will appear. Click on the
OK button.

15. Select File System from the Categories selection box.
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16. When the File System Parameters dialog box appears (Figure 4.8), click NCP
File Commit to OFF (the box should be empty).

Figure 4. 8 - SET Parameters File System Dialog Box

NOTE:  Turning this function off will free up processor time so the server
doesn't have to look for NCP files to flush. Changing this parameter will have
no adverse effect on your file server.

17. Click Immediate Purge Of Deleted Files box to ON (the box should now have
an X in it).

NOTE:  Turning this parameter on will decrease read time because all deleted
files will be purged without delay. Be aware that when a deleted file is purged, it
can never be salvaged again. If you feel you may need to salvage a deleted file
do not use this command.

18. Click on the Set button to save your changes to the Directory Caching category.
The SET Parameters Function Successful dialog box will appear (Figure 4.9).
Click on the OK button.
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Figure 4. 9 - SET Parameters Function Successful Dialog Box

19. Select Disk from the Categories selection box.

20. The Disk Parameters dialog box now appears (Figure 4.10). Turn Enable Disk
Read After Write Verify to OFF.

Figure 4. 10 - SET Parameters Disk Dialog Box

NOTE:  If you're not sure whether your server drive includes hardware level
read after verify, consult your disk manufacturer before changing this parameter.

21. Click on the Set button to save your changes to the Disk category. The SET
Parameters Function Successful dialog box will appear. Click on the OK button.

22. You need to create another Tune file that resets the servers SET parameters back
to the original NetWare defaults. To do this we need to click on the New button.

23. The New Tune File dialog box will appear. Make sure your radio button
selection is for NetWare Default Values.
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24. For the Name field, enter RESET.NTT (Figure 4.11).

Figure 4. 11 - Creating the RESET.NTT File

25. Click on the OK button.

26. The new Tune file will be listed in the Servers/Tune Files selection box on the
lower left of the screen. Click on the Close button.

You now have two Tune files:
• BACKUP.NTT, which contains the six modified SET parameters.

• RESET.NTT, which contains the default values for NetWare. In the next section
you will learn how to schedule the tune file by creating a Tune Job.

Scheduling the Tune Files
You have created the two Tune files for our tune example. The second step is to
schedule a time for the Tune files to run. A scheduled job is called a Tune Job.
Scheduling a Tune Job is called Time Tuning.

1. Click on the Tune pull-down menu from NetTune’s menu bar.

2. Select the Time Tune command from the Tune pull-down menu.

3. The Time Tune dialog box will appear (Figure 4.12). You need to create two
Tune Jobs for each Tune file. First select a file server for tuning from the
Server(s) selection box.



Chapter 4:   Using SmartTune 47

Figure 4. 12 - Time Tune Dialog Box

4. Select the BACKUP.NTT tune file from the Tune Files selection box by
highlighting the Tune file’s name.

5. Schedule the BACKUP.NTT Tune job to run:

• For Job Name, type in BACKUP.

• For Frequency, choose Daily.

• Set Hour to 23.

• Set Minute to 0. (This schedules BACKUP.NTT to run at 11:00 p.m.)

• Click the Save button to save the Time Tune Job.

NOTE:  Remember, your example backup starts at 11:01 p.m. If your backup
takes place at a different time, schedule BACKUP.NTT to run one minute
before your backup begins.

You now see the BACKUP.NTT scheduled as a Tune Job, and listed in the
Time Tune Job List window (Figure 4.13).
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Figure 4. 13 - Scheduling the BACKUP.NTT as a Tune Job

6. Repeat this process for RESET.NTT by clicking on the New button.

7. Schedule the RESET.NTT tune job to run:

• For Job Name, type in RESET.

• For Frequency, choose Daily.

• Set Hour to 6.

• Set Minute to 0. (This schedules RESET.NTT to run at 6:00 a.m.)

• Click the Save button to save the Time Tune Job.

NOTE:  Remember that our example backup ends at 5:55 a.m. If your backup
finishes at a different time, then schedule RESET.NTT to run five minutes after
your backup completes.

8. You now see the RESET.NTT scheduled as a Tune Job, and listed in the Time
Tune Job List window (Figure 4.14).
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Figure 4. 14 - Scheduling the RESET.NTT as a Tune Job

9. The Tune files are now scheduled to run. Click on the Close button to exit.

10. The last step of our Tune File example will require you to run two backups:

• One night backup without Time Tuning.

• The next night backup with Time Tuning.

Remember to check your tape backup LOG file for the time comparison.

You can also disable a Tune Job by placing an X in the Job Disable check box
when the Tune file is highlighted. If you wish to delete a Tune file, highlight the
Tune file and press the Delete button (this is a permanent delete).

Modifying SET Parameters Through SmartTune
The two methods just described for modifying SET parameters may require some
NetWare knowledge and experience. You need no prior experience with set
parameters to successfully use SmartTune. SmartTune’s sophisticated artificial
intelligence is able to automatically adjust SET parameters on the fly, based on
collected real-time data.

As SmartTune detects changes in real-time, it will make changes accordingly. The
resulting optimization helps eliminate bottlenecks or potential dangers associated
with pushing the envelope on your operating system. The main advantage of the
SmartTune module is providing optimization while you carry on with administration
duties without having to worry about manually adjusting parameters.
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SmartTune’s Tuning Options feature provides you with greater flexibility for
managing performance and optimization on your server than any software product
on the market today.

SmartTune Control of Optimization

For those who prefer to have SmartTune handle all aspects of optimizing the
network server:

1. Select the Tune pull-down menu from NetTune’s menu bar.

2. Select SmartTune from the Tune pull-down menu.

3. When the SmartTune dialog box appears (Figure 4.15), it will display the
Tuning Options dialog box. Select the file server you wish to tune by clicking
on the appropriate server, located in the Servers selection box.

Figure 4. 15 - SmartTune Tuning Options Dialog Box

4. If the Tuning Options dialog box isn’t displaying, select Tuning Options from
the Options selection box.

5. Select Non-Specific from the Server Environment selection box.

6. If the SmartTune check box is not enabled, the Enable SmartTune (Automatic
Tuning) check box will be empty.

7. Make sure it is enabled by clicking on the check box to place an X in it. This
will enable SmartTune to make all modifications for a server’s SET parameters.

8. When this is done, click on the Set button to save your choices, then click on the
Close button to exit.
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Disabling SmartTune

If you no longer wish to have SmartTune automatically tune all aspects of the
selected server, remove the X from the Enable SmartTune (Automatic Tuning) check
box (Figure 4.15) to disable SmartTune.

Figure 4. 16 - Disabling SmartTune Check Box

To do this, click on the Enable SmartTune (Automatic Tuning) check box.

Then click on the Set button to save your choice.
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NOTES
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Chapter 5 File Menu Introduction

The File menu is located in NetTune’s menu bar at the top of the window. It
contains a list of NetTune commands for the currently selected icon or object.

Figure 5. 1 - File Menu Pull-Down Commands

NCF Command

Selecting this command will open another selection window for AUTOEXEC.NCF
and STARTUP.NCF.

To open the file you wish to view or edit, click on the desired file.

Close Command

The Close command will close the selected NCF file.

Save Command

The Save command is used to save the selected NCF file.

Print Command

The Print Command is used to print an active window.
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Print Preview Command

When you choose the Print Preview command, you can display either full page or
two page views of the active file or graph. While you are in print preview, you
cannot edit text or choose other commands.

Print Setup Command

The Print Setup command is used to select a printer driver, and set up the driver
options.

Print Setup Dialog Box

The Print Setup dialog box (Figure 5.2) shows the currently selected printer options.
After you designate a printer, you can select page orientation and page size options.
The number of options will vary depending on the printer driver you select.

Figure 5. 2 - Print Setup Dialog Box

Print quality is set by selecting the Options button. Your Printer Options dialog box
may vary depending on your operating system (i.e. Windows for Work Groups,
Windows 3.1).

Exit Command

The Exit command is used to exit the NetTune program.

NOTE:  Remember to save all NCF files before exiting NetTune.
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Chapter 6 Edit Menu and Toolbar Introduction

Clicking on Edit in the Menu Bar causes the Edit menu to appear (Figure 6.3). A
number of edit commands are available in the pull-down menu.

Figure 6. 3 - Edit Pull-Down Menu

Editing Overview
There are three basic text editing techniques:

• Inserting text

• Deleting text

• Blocking text.

Inserting Text

Position the cursor to the spot in the file where you want to insert text, and begin
typing.

Deleting Text

Position the cursor to the left of the text you want to delete, and press the Delete key.
If you prefer, position the cursor to the right of the text to be deleted, and press the
Backspace key.

Blocking Text

A block of text is any group of characters you have highlighted. The editor treats the
highlighted text as a single unit.
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Keyboard Navigation
The following keyboard navigation commands are available in the text editor:

Keys Move the Cursor

Left Arrow Left one character

Right Arrow Right one character

Up Arrow Up one line

Down Arrow Down one line

Home To the beginning of the current line

End To the end of the current line

Page Up Up one screen

Page Down Down one screen

Ctrl+Left Arrow Left one word

Ctrl+Right Arrow Right one word

Ctrl+Home To the top of the file

Ctrl+End To the bottom of the file
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Edit Menu
The Edit menu is located in the Menu Bar at the top of the window. It contains a list
of edit commands for the currently selected system file.

Figure 6. 4 - Editing AUTOEXEC.NCF

To open the pull-down command menu, position the mouse cursor over the Edit
menu, and click the left mouse button.

A NetTune command can be selected by pointing to the command and clicking the
left mouse button.



58 Using NetTune

Undo Command

The Undo command is used to undo your most recent edit.

There are 2 methods for selecting the Undo command:

1. From the Edit menu, choose the Undo command.

2. From the keyboard, press the <Ctrl> <Z> keys.

Cut Command

The Cut command deletes highlighted text and pastes the text into the clipboard.
You can paste the clipboard contents anywhere in the file.

There are 3 methods for selecting the Cut command:

1. From the Edit menu, choose the Undo command.

2. From the keyboard, press the <Ctrl> <X> keys.

3. Use the Cut icon on the Toolbar.

 

Copy Command

The Copy command copies highlighted text to the clipboard. You can paste the
clipboard contents anywhere in a file. Many NetTune Windows (containing Graphs
and Text) can be copied to the clipboard.

There are 3 methods for selecting the Copy command:

1. From the Edit menu, choose the Copy command.

2. From the keyboard, press the <Ctrl> <C> keys.

3. Use the Copy icon on the Toolbar.
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Paste Command

The Paste command is used to copy text from the clipboard into one or more
locations in your file. You must position the cursor where you want the text to
appear.

There are 3 methods for selecting the Paste command:

1. From the Edit menu, you can choose the Paste command.

2. From the keyboard, press the <Ctrl> <V> keys.

3. Use the Paste icon on the Toolbar.

 

Toolbar
The Toolbar presented in Figure 6.3, is a graphical bar with command icons that
perform some of the most common commands in the NetTune program.

Figure 6. 5 - Toolbar

To use the Toolbar, move the mouse pointer to the icon representing the command
you want to execute, and click the mouse button. For more information regarding
the Toolbar icons, see Chapter 12.15 NetTune Toolbar Icons.

Status Bar
The Status Bar at the bottom of NetTune’s desktop is displayed by default. The
Status bar provides the following information:

• Help key identification

• The file server’s name

• The file server’s NetWare version

• The user’s name

• Information on the keyboard’s lock status
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Chapter 7 Tune Menu Introduction

Figure 7. 1 - The Tune Menu Pull-Down Commands

The Tune pull-down menu, located on the NetTune menu bar, allows you to
optimize server performance. It is only functional if you have the SmartTune NLM
loaded, otherwise, the Tune pull-down menu will be grayed-out.

Optimizing network performance can be accomplished by:

• Manually adjusting internal NetWare operating system SET parameters.

• Creating custom Tune files and scheduling parameter changes through the Tune
files.

• Using SmartTune to automatically adjust server(s) SET parameters on the fly.

SET Parameters Command
The SET parameters command allows you to modify SET parameters for the
following nine NetWare categories:

1. Communication

2. Memory

3. File Caching

4. Directory Caching

5. File System

6. Locks

7. Transaction Tracking

8. Disk

9. Miscellaneous
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Along with modifying SET parameters, you can also create custom Tune files. Tune
files contain modified SET parameters for a file server. You can schedule Tune files
to change a server’s SET parameters at a specified time. You can also export SET
parameters from one server or Tune file to other servers or Tune files.

The choices available for modifying SET parameters, creating Tune files, or
exporting SET parameters are available through NetTune’s Set Parameter dialog
boxes.

SET Parameter Dialog Boxes

There are nine Set Parameter dialog boxes which provide one for each NetWare
category found in the Categories selection box (Figure 7.2). Each Set Parameter
dialog box is similar in design, and they all share a similar look and feel. Some of
the Set Parameter dialog boxes have an asterisk (*) before the SET parameter
command. This asterisk indicates the change will be made to either the server’s
AUTOEXEC.NCF or STARTUP.NCF files. If there is no asterisk before the SET
parameter command, then the SET parameter change will be made directly to the
server’s memory.

At the top left of the Set Parameter dialog box is the Categories selection box. Here
you select the category of NetWare SET parameters you wish to modify.

Figure 7. 2 - NetWare Categories Window
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At the lower left of the SET parameters dialog box is the Servers\Tune Files
selection box (Figure 7.3) which allows you to select a server (or Tune file) for
modifying.

Figure 7. 3 - Server Tune Files Window

NOTE:  Only servers running the SmartTune NLM will be displayed in the
Servers\Tune Files selection box

To view Tune files belonging to a particular server, double-click on the file server
name. This will expand the server list into a Tune file list which contains all Tune
files associated with the selected file server (Figure 7.4).

Figure 7. 4 - Expanded Tune File List for Server HawkNet

At the bottom left of the Set Parameter dialog box is the Information selection box
(Figure 7.5) which contains the following information:

• The NetWare version

• The NetWare user limit

• NetTune version

• NetTune Read\Write status

Figure 7. 5 - Information Window
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The Read\Write status of NetTune should be noted. If SMARTUNE.NLM is not
loaded in write mode, you cannot alter any SET parameters or Tune files.

NOTE:  NetWare version 3.11 vs. NetWare version 3.12

If you are modifying multiple servers that are running version 3.11 and version 3.12
of NetWare, you will not see the identical number of SET parameters in the Set
Parameter dialog boxes. This is because NetWare version 3.12 contains 9 additional
SET parameters.

The SmartTune SET parameters dialog boxes includes push buttons. Table 7.1
below describes the function of each push button.

New The New button creates a new Tune file
containing either newly modified SET
parameters or Novell’s default SET parameters.
For more on the New button see Creating a
New Tune File, Chapter 7.

Export The Export button will export SET parameters
from one server, or Tune file, to other servers or
Tune files. For more on the Export button see
Exporting SET parameters to a Server or Tune
File, Chapter 7.

Set The Set button will save any changes you make
to the SET parameters for the currently selected
file server or Tune file.

Undo The Undo button will undo any changes you
made to the current SET parameters dialog box.

Default The Default button will display the NetWare
default values for the currently selected file
server or Tune file.

Help The Help button will bring up the NetTune
Help index.

Close The Close button will end your session and
exit.

Table of SmartTune’s Push Buttons for the SET Parameters
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Selecting an Option

Options that appear in the Set Parameter dialog boxes include: check boxes, text
boxes, and push buttons. Select an option via mouse, and click or press the Tab key
repeatedly until the desired option is activated.

Check Boxes

Toggle a check box option on or off by selecting or deselecting the check box.
When the check box is selected (On), an X appears inside the check box.

Text Boxes

Once selected, a text box allows you to type an entry or modify an existing
parameter. You may also use the scroll bar arrows alongside the text box to increase
or decrease a parameter.

Push Buttons

Push buttons are selected by clicking on the button with the mouse, or by using the
Tab and Enter keys.

Creating a New Tune File

To create a new Tune file:

1. Select SET parameters from the Tune pull-down menu.

2. When the SET parameters dialog box appears, click on the New button to open
the New Tune File dialog box (Figure 7.6).

Figure 7. 6 - New Tune File Dialog Box

3. If you choose to use NetWare’s defaults, then click on the NetWare Defaults
Values button. If you choose to use values that will be modified by you, then
select the Server’s Current Values button.
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4. Enter a Tune file name into the Name field. Give the Tune file a descriptive
name and a .NTT file extension. This enables NetTune to identify the file as a
Tune file.

5. After you have entered a descriptive name, click on the OK button.

6. Click on the NetWare category that contains the SET parameters you wish to
modify.

7. When the selected NetWare category dialog box appears, modify the SET
parameters as needed. When you’re finished, click on the SET button to save
those modifications to your new Tune file.

8. If you wish to modify additional SET parameters from other NetWare
categories, and save them to your new Tune file, continue from Step 6.

NOTE:  If you forget to save any modified SET parameters, you will see a
dialog box that asks if you wish to save your changes. You must decide before
you can alter any other Set Parameter categories.

9. When you have finished modifying all the SET parameters, click on the Set
button to save any additional changes. Click on the Close button to end your
session.

Exporting SET Parameters to a Server or Tune File

The Export function copies all SET parameters from a source, either a file server or
Tune file, to multiple destinations that are other file servers or Tune files. This
feature allows you to create a duplicate set of SET parameters for another server or
Tune file without selecting each SET parameter individually.

NOTE:  The Export function does not copy Tune files to other destinations. It
copies the SET parameters from a source to multiple destinations (i.e., other Tune
files or servers).
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Exporting a Server’s SET Parameters to Another Server

To export a file server’s SET parameters to another file server:

1. Select a file server from a group icon listed in the Source selection box. To do
this double click on the group icon. This will expand into the server list.

2. When the source server list appears, click on the file server that contains the
values you wish to export. The Source: SET parameters Name and Current
Value window will now be displaying the current SET parameters for the
selected server. You can view all the SET parameters for that server by scrolling
through the Source: SET parameters Name and Current Value window.

3. When you are satisfied that these source values are those that you wish to use,
then double-click the group icon from the Destination window that contains the
destination server.

4. When the destination server list appears, click on the server(s) you wish to
designate as the receiver of these SET parameters (Figure 7.7).

Figure 7. 7 - Exporting SET Parameters

5. When you have selected the destination server(s), click on the Export button.
This will export the source SET parameters to the destination server’s NCF
file(s).

6. Click on the Close button to end your session.
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Exporting a Tune File to Another Tune File or Server

Exporting a Tune file to multiple file servers (or other Tune files) follows the same
procedures found in Exporting a Server’s SET parameters to another Server,
Chapter 7. While the server list is displaying, double click on the sever list to
expand the list and display the Tune file list for both source and destination. Click
on all destination servers or Tune files that you want to receive the exported SET
parameters.

Communications Set Parameters Dialog Box

The Communication SET parameters dialog box controls the communication buffer
settings. There are several parameters that can be adjusted in the Communications
dialog box (Figure 7.8).

Figure 7. 8 - Communications SET Parameter Dialog Box

Watchdog Parameter

Watchdog parameters are used to make sure workstations are currently connected.

If the server has not received a packet from a workstation in a certain time (set by the
Delay Before First Watchdog parameter), a watchdog packet is sent to the station.

If the station does not respond within a certain time (set by the Delay Between
Watchdog parameter), another watchdog packet is sent.
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If the station still does not respond to a certain number of watchdog packets
(determined by the Number of Watchdog Packets parameter), the server assumes
that the station is no longer connected and clears the station's connection.

Packet Receive Buffer Parameters

Areas in the file server's memory are set aside to hold data packets. These packets
remain in the buffers while being processed by the file server.

Write Enable Switch:

If you try to alter any of the Set parameters, and the Set button is disabled, it’s
because SmartTune was loaded in Read Only mode. See Chapter 3 for more
information concerning the Write enable switch.

Console Display Watchdog Logouts

This parameter determines whether a console message will be displayed when a
workstation connection is cleared.

A smooth running network does not require the display of this parameter.

Limits: On or Off

Default: Off

Enable Packet Burst Statistics Screen

This parameter displays the NCP packet burst statistics screen.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: On or Off

Default: Off

Reply To Get Nearest Server

This parameter determines whether this server will respond to “Get Nearest Server”
requests from workstations that are attempting to locate a server.

Limits: ON or OFF

Default: ON
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Allow LIP

This parameter allows the client’s rights to be changed.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: On or Off

Default: On

Number of Watchdog Packets

This parameter sets the number of watchdog packets the server will send out
(without receiving a workstation reply) before disconnecting the workstation.

Limits: 5 to 100

Default: 10

Delay Between Watchdog Packets

This parameter sets the amount of time between watchdog packets after the server
has sent out the first watchdog packet.

Limits: 9.9 seconds to 10 minutes 26.1 seconds

Default: 59.3 seconds

Delay Before First Watchdog Packet

Sets the amount of time the server waits without receiving a workstation request
before sending out the first watchdog packet.

Limits: 15.7 seconds to 20 minutes 52.3 seconds

Default: 4 minutes 56.6 seconds
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Maximum Physical Receive Packet Size

This parameter sets the maximum packet size the file server can transmit to any
network. The default packet size is 1KB (This includes the packet header and data).

Considerations

The default is also acceptable for Token-Ring or Ethernet boards. Set this parameter
to the largest packet size allowed by your network boards.

NOTE:  This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.

Limits for 3.11: 618 to 4202

Default for 311: 1130

Limits for 3.12: 618 to 24682

Default for 3.12: 1514

Maximum Packet Receive Buffers

This sets the maximum number of packet receive buffers that the operating system
can allocate.

Considerations

EISA and Micro Channel server bus master boards require at least 5 buffers per
board.

Use NetWare's MONITOR.NLM to determine if the board is producing "No ECB
available count " errors. This can be done by selecting LAN Information from the
Monitor program. If you detect these errors, increase the parameter to allow for 10
packet receive buffers per board.

If you observe that the number of allocated services processes have reached fixed
limits, increase the "maximum number of service processes" parameter.
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NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the current server usage for packet receive buffers and service
processes.

Limits for 3.11: 50 to 2000

Default for 3.11: 100

Limits for 3.12: 50 to 2000

Default for 3.12: 400

Minimum Packet Receive Buffers

This parameter sets the minimum number of packet receive buffers that the operating
system can allocate. The operating system will set the minimum number of buffers
when the server boots (STARTUP.NCF).

Considerations

If you have EISA and Micro Channel server bus master boards in your server, and
you are receiving “No ECB available count" errors immediately after the file server
boots, increase this parameter. Each board needs to have at least 5 packet receive
buffers.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view current server usage of packet receive buffers. If the parameter is
set higher than 10, and the server is responding slowly after it has been booted,
increase this parameter.

This parameter cannot be modified at the console prompt. SmartTune will modify
the STARTUP.NCF. Reboot the file server to implement the new parameter.

Limits: 10 to 1000

Default: 100
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New Packet Receive Buffer Wait Time

This parameter sets the length of time the operating system will wait after receiving
a request for another packet receive buffer and before granting an additional buffer.

This parameter is used to prevent the operating system from granting an abnormal
amount of packet receive buffers during a period of sudden peak usage.

Never change this parameter on file servers with an EISA bus master board.

Limits: 0.1 seconds to 20 seconds

Default: 0.1 seconds

NCP Packet Signature Option

This parameter option controls the NCP packet signatures.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: 0, 1, 2, 3

Default: 1

0 = Don’t do packet signature

1 = Do packet signatures only if the client requests them

2 = Do packet signatures if supported

3 = Requires packet signatures
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Enable IPX Checksums

This parameter enables the checksums of IPX packets. This command applies only
to NetWare version 3.12 users. NetWare version 3.11 users will not see this
parameter displayed in the Communications dialog box.

Limits: 0, 1, 2

Default: 1

0 = No checksums

1 = Do a checksum if enabled at the client

2 = Requires checksum

Memory Set Parameters Dialog Box

The Memory Set parameters dialog box (Figure 7.9) is used to control the size of the
dynamic memory pool, the block size of cache buffers, and the automatic registering
of memory on EISA bus computers.

Figure 7. 9 - Memory SET Parameters Dialog Box
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Auto Register Memory Above 16MB

This parameter is used to control the automatic register of memory above 16MB in
EISA computers.

Considerations

Set to ON if you want the operating system to register memory above 16MB.

Set to OFF if your file server has a network board or a disk adapter board that uses
on-line DMA or AT bus mastering.

NOTE:  This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.

Limits: ON or OFF

Default: ON

Maximum Alloc Short-Term Memory

This parameter sets the amount of memory the operating system allocates to the
Short-Term Memory pool. The default setting is sufficient for 250 users, each with
26 drive mappings.

Considerations

Increase this parameter if the file server issues warnings that an operation cannot be
completed because the memory pool has reached its limits.

Decrease this parameter if the file server is allocating more memory to the pool than
normally required.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the amount of memory allocated to the "Alloc Memory Pool."

Limits for 3.11: 50000 to 16777216

Default for 3.11: 2097152

Limits for 3.12: 50000 to 33554432

Default for 3.12: 8388608
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Cache Buffer Size

This parameter sets the block size of the cache buffer.

Considerations

If block allocations are greater than 4KB on all volumes, increasing this parameter
may increase performance.

If block allocations are less than 4KB on all volumes, increasing this parameter will
decrease performance.

NOTE:  Volumes that have block allocation sizes smaller than the cache block size
will not be mounted.

If block allocation sizes vary between volumes, make this parameter no larger than
the smallest block allocation size.

NOTE:  This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.
This parameter may also be modified using the -c option when starting the
SERVER.EXE program.

Limits: 4096, 8192, or 16834

Default: 4096

File Caching Set Parameters Dialog Box

The File Caching SET parameters dialog box (Figure 7.10) is used to set file cache
memory parameters.

Files that are being read from or written to are kept in the file cache memory buffers.
File caching holds frequently used files in file cache memory longer to facilitate
faster access. The number of files held in memory depends on the number of file
cache buffers available.
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Figure 7. 10 - File Caching SET Parameters

Maximum Concurrent Disk Cache Writes

This parameter sets the number of write requests for changed file data that can be put
into the elevator before the disk head begins a sweep across the disk.

Considerations

Increasing this parameter makes the servicing of write requests more efficient.

Decreasing this parameter makes the servicing of read requests more efficient.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the number of dirty cache buffers. If the number is above 70% of
the total cache buffers, increase this parameter to optimize the write speed.

Limits for 3.11: 10 to 100

Default for 3.11: 50

Limits for 3.12: 10 to 1000

Default for 3.12: 50
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Dirty Disk Cache Delay Time

Sets the amount of time the operating system will keep a write request (that does not
fill a cache buffer) in memory before writing the request to disk.

Considerations

Increase this parameter if users are making many small write requests.

Decreasing this parameter slightly reduces the chances of losing data. However, you
may drastically reduce performance.

Limits: 0.1 seconds to 10 seconds

Default: 3.3 seconds

Minimum File Cache Buffer Report Threshold

This parameter sets a warning threshold above the minimum number of cache buffer
settings so that the operating system will alert you when the warning threshold has
been reached.

Considerations

Warning Threshold Message:

Number of cache buffers is getting low.

Regardless of how this parameter is set, the operating system displays the following
message when the memory allocation resources reach the minimum number of cache
buffers:

Cache memory allocator exceeded minimum cache buffer left limit.

Limits: 0 to 1000

Default: 20

Minimum File Cache Buffers

This parameter sets the minimum number of cache buffers the operating system
allows for file caching. The operating system uses all memory not allocated for other
processes for file caching. As processes request memory, the operating system
releases memory until the limit of this parameter is reached.
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Considerations

Setting this parameter too high may prevent other processes from allocating required
memory resources.

Limits: 0 to 1000

Default: 20

Reserved Buffer Below 16 Meg

This parameter sets the number of file cache buffers to be kept for device drivers
unable to access the memory above 16 MB.

NOTE:  This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.

Limits for 3.11: 8 to 200

Default for 3.12: 16

Limits for 3.11: 8 to 300

Limits for 3.12: 16

Read Ahead LRU Sitting Time Threshold

This parameter insures that if the LRU (Least Recently Used) sitting time is below
this threshold, then the read ahead will not take place.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: 0 second to 1 hour

Default: 10 seconds
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Read Ahead Enabled

This parameter performs background reads to move the blocks that will be requested
into the cache in advance. This is done as long as sequential file access is occurring.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: ON or OFF

Default: ON

Directory Caching Set Parameters Dialog Box

The Directory Caching SET parameters dialog box (Figure 7.11) is used to set
directory cache buffer parameters. Directory caching facilitates fast access to
frequently used directories. A directory entry stays in a cache buffer as long as it is
being frequently accessed. If used infrequently, the operating system will overwrite
the entry.

A trade-off exists between directory and file caching. When the number of directory
cache buffers is increased, the number of file cache buffers decreases. Directory and
file caching requirements must be carefully balanced for maximum system
performance.

Figure 7. 11 - Directory Caching SET Parameters
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Directory Cache Buffer NonReferenced Delay

This parameter sets the length of time a directory entry must be cached before it can
be overwritten by another directory entry.

Considerations

Increasing this parameter causes the operating system to allocate more directory
cache buffers.

Decreasing this parameter causes directory access to slow down, but decreases the
need for additional cache buffers.

Limits: 1 second to 5 minutes

Default: 5.5 seconds

Directory Cache Allocation Wait Time

This parameter sets the length of time the operating system must wait between the
allocation of new directory cache buffers. During this time period all directory cache
buffer allocation requests are ignored.

Considerations

Increasing this parameter will cause the operating system to be slow in allocating
directory cache buffers.

Decreasing this parameter causes more memory resources to be allocated to
directory caching.

Limits: 0.5 seconds to 2 minutes

Default: 2.2 seconds
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Dirty Directory Cache Delay Time

This parameter sets the length of time the operating system keeps a directory table
write request in memory before writing it to disk.

Considerations

Increasing this parameter increases operating system performance. However, the
probability of the directory table becoming corrupted is also increased.

Decreasing this parameter reduces operating system performance due to an added
number of disk writes. However, the probability of the directory becoming corrupted
is reduced.

Limits: 0 to 10 seconds

Default: .5 seconds

Maximum Concurrent Directory Cache Writes

This parameter sets the number of write requests from the directory cache buffers
that can be placed into the elevator before the disk head begins a sweep across the
disk.

Considerations

Increasing this parameter improves the efficiency of servicing write requests.
However, the servicing of read requests becomes less efficient.

Decreasing this parameter improves the efficiency of servicing read requests.
However, the servicing of write requests becomes less efficient.

Limits: 5 to 50

Default: 10
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Maximum Directory Cache Buffers

This parameter sets the number of permanent directory cache buffers the operating
system may allocate.

Considerations

Increase this parameter if the file server responds slowly to directory searches.

Decrease this parameter if too much memory is being allocated for directory
caching.

NOTE: If users are notified by the operating system that the server is low on
memory, this parameter should be one of the first to be reduced.

You must reboot the file server to return the memory to the cache buffer memory
pool.

Limits: 20 to 4000

Default: 500

Minimum Directory Cache Buffers

This parameter sets the minimum number of cache buffers that the operating system
can allocate for directory caching. Set this parameter high enough that directory
searches can be done quickly.

Considerations

Increase this parameter no higher than necessary. If the minimum number of cache
buffers is not used, the buffers cannot be reallocated to file caching. They remain
unusable.

NOTE:  If the file server is responding slowly to directory searches, use the
MONITOR.NLM or NetTune to view current directory cache buffer statistics.

Limits: 10 to 2000

Default: 20



84 Using NetTune

File System Set Parameters Dialog Box

The File System SET parameters dialog box (Figure 7.12) controls the following
functions:

• Maximum settings for files and directories

• Volume low warnings

• File purging

• Wait times

Figure 7. 12 - File System SET Parameters
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Maximum Subdirectory Tree Depth

This parameter sets the number of subdirectories the operating system will support.
Some DOS directories are not capable of supporting more than 10 levels if the
directories have eleven-character names.

Considerations

Increase this parameter if application support trees are deeper than 25 levels.

Decrease this parameter if your application supports only shallow tree structures.

NOTE: This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.

Limits: 10 to 100

Default: 25

Maximum Extended Attributes per File or Path

This parameter sets the number of extended attributes that can be assigned to a file
path for all volumes on the server.

Limits for 3.11: 4 to 512

Default for 3.11: 32

Limits for 3.12: 4 to 512

Defaults for 3.12: 8

Maximum Percent of Volume Used by Directory

This parameter sets a limit on the portion of a volume that may be used as directory
space.

Limits: 5 to 50

Default: 13
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Maximum Percent of Volume Space Allowed for Extended Attribute

This parameter sets a limit on the portion of volume space that may be used for
extended attribute storage.

NOTE:  This parameter only takes effect while the volume is being mounted.

Limits: 5 to 50

Default: 10

File Delete Wait Time

Sets the amount of time the operating system is required to wait before marking a
salvageable file as purgeable. When the volume becomes full, the operating system
begins to delete the oldest purgeable files to create free space on the volume.

Considerations

Increase this parameter as necessary for the system users.

If the volume becomes full, files that have not met the limit will still be purged.

Limits: 0 seconds to 7 days

Default: 5 minutes 29.6 seconds

Minimum File Delete Wait Time

This parameter sets the length of time a file must stay in a salvageable state on the
volume. Deleted files that have no minimum time requirements will not be purged
automatically, even if the volume is full and users are unable to create new files.

Limits: 0 to 7 days

Default: 1 minute 5.9 seconds

Turbo FAT Re-Use Wait Time

This parameter sets the length of time a turbo FAT buffer remains in memory after
an indexed file is closed. Once the wait state has elapsed, the operating system can
allocate the buffer to another indexed file.
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Considerations

Increase this parameter if you want the Turbo FAT index to remain in memory for
an extended period of time.

Decrease this parameter if want memory immediately released to service the next file
to be indexed.

Limits: 0.3 seconds to 1 hour 5 minutes 54.6 seconds

Default: 5 minutes 29.6 seconds

Volume Low Warning Threshold

This parameter sets the minimum amount of free disk blocks that can remain on a
volume before the operating system issues a warning.

Considerations

The Block size is determined when a volume is created.

NOTE:  If volumes have been assigned different block sizes, each volume will have
a different amount of free space when the warning is issued.

Limits: 0 to 100000 Blocks

Default: 256 Blocks

Volume Low Warning Reset Threshold

This parameter sets the amount of disk space that must be freed before a second
warning is issued. The first warning is controlled by the "Volume Low Warn All
Users" parameter.

If a volume is hovering at its volume low threshold, this parameter prevents
repetitious warnings every time the volume dips below the threshold.

Limits: 0 to 100000 Blocks

Default: 256 Blocks
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NCP File Commit

This parameter controls whether applications are allowed to flush all pending file
writes to disk when a File Commit NCP is issued, instead of waiting for the cache
manager to flush to disk.

Considerations

Set to ON to immediate flush from cache to disk when a File Commit NCP is issued.

Limits: ON or OFF

Default: ON

Volume Low Warn All Users

Setting this parameter to ON will have the operating system warn all users when a
volume is almost full.

Considerations

If you choose not to warn users, monitor volume statistics daily with the NetWare
CHKVOL or VOLINFO commands.

Limits: ON or OFF

Default: ON

Immediate Purge Of Deleted Files

This parameter controls the salvageable file features.

Considerations

If set to ON, all NetWare salvage features are disabled. All files are immediately
purged when deleted.

If set to OFF, files may be salvaged with the NetWare SALVAGE utility.

Limits: ON or OFF

Default: OFF
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Locks Set Parameters Dialog Box

The File Lock SET parameters dialog box (Figure 7.13) controls the number of:

• Open files each station can have

• Open files the operating system can handle

• Record locks the operating system can handle

These parameters control three types of locks:

• File

• Physical Record

• Logical Record

File Lock

This type of lock secures the entire file and prevents other stations from accessing
the file.

Physical Record Lock

This type of lock controls data access by multiple users. It prevents other users from
altering a file. The operating system enforces this lock.

Logical Record Lock

This lock type controls data access by multiple users. It prevents users from altering
certain sections of data in a file. The application enforces this lock.

Figure 7. 13 - Locks SET Parameters
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Maximum File Locks

This parameter sets the number of opened and locked files the operating system can
handle.

Considerations

Increase this parameter if the current number of open files is near or equal to the
default setting.

Decrease this parameter to restrict the number of file server resources.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the number of files that are open during peak usage

Limits: 100 to 100000

Default: 10000

Maximum File Locks Per Connection

This parameter controls how many opened and locked files a station can use at a
time.

Considerations

Increase this parameter when an application cannot open enough files and fails. An
OS/2 station may require a higher default than 250.

You may also be required to increase the number of file handles in the workstation's
SHELL.CFG file.

Decrease this parameter if workstations are using too many file server resources.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view how many opened and locked files a workstation is using.

Limits: 10 to 1000

Default: 250
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Maximum Record locks

This parameter sets the number of record locks the operating system can handle.

Considerations

Increase this parameter if users are having trouble running applications, and are
receiving messages indicating that an insufficient number of memory locks are
available.

Decrease this parameter if users are using too many file server resources.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the number of record locks a workstation is using.

Limits: 100 to 200000

Default: 20000

Maximum Record Locks Per Connection

This parameter sets the number of record locks a station can use at one time.

Considerations

Increase this parameter when an application fails because it is unable to lock enough
records.

Decrease this parameter if workstations are using too many file server resources.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view how many record locks a workstation is using.

Limits: 10 to 10000

Default: 500
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Transaction Tracking SET Parameters Dialog Box

The Transaction Tracking SET parameters dialog box (Figure 7.14) is used to SET
parameters that control the Transaction Tracking System (TTS). A transaction is a
set of write operations that must be completed.

The Transaction Tracking System guarantees that a set of write operations will either
be written to disk in complete form, or backed out if incomplete. This ensures
database integrity in the event that the workstation, file server, or LAN fails before a
transaction has been completed.

Normally, it will not be necessary to change most of these parameters.

Figure 7. 14 - Transaction Tracking SET Parameters

Auto TTS Backout Flag

This parameter controls whether a crashed file server will backout any incomplete
transactions when rebooted.

Considerations

If set to ON, the file server will automatically back out any incomplete transactions
during a reboot.

If set to OFF, the file server prompts you with the following message before
completing its bootstrap:
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Incomplete transaction(s) found. Do you wish to back them out?

NOTE:  This parameter cannot be modified at the console prompt. SmartTune will
modify the STARTUP.NCF. Reboot the file server to implement the new parameter.

Limits: ON or OFF

Default: OFF

TTS Auto Dump

This parameter controls whether a file will be created to log transaction backout
data.

Considerations

If set to ON, backout data is written to the TTS$LOG.ERR file in the SYS volume.
You can either read the file with a text editor, or print the file.

If set to OFF, the backout data is not saved.

Limits: ON or OFF

Default: OFF

TTS Backout File Truncation Wait Time

This parameter sets the length of time allocated blocks remain available for the TTS
backout file when the blocks are not being used.

Limits: 1 minute 5.9 seconds to 1 day 2 hours 21
minutes 51.3 seconds

Default: 59 minutes 19.2 seconds
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TTS Unwritten Cache Wait Time

This parameter sets the length of time a block of transactional data can be held in
memory. In the case where a transactional data block has reached its time limit, other
write requests are held up while the data block is written to disk.

Limits: 11 seconds to 10 minutes 59.1 seconds

Default: 1 minute 5.9 seconds

Maximum Transactions

This parameter sets the number of transactions that may occur at the same time.

Limits: 100 to 10000

Default: 10000

Disk SET Parameters Dialog Box

The Disk SET parameters dialog box (Figure 7.15) controls one part of Hot Fix
redirection which can occur during a write request, read request, or a read-after-write
verification.

Write Request Hot Fix Redirection

This hot fix occurs when the disk reports an error during a write request. The
operating system marks the block as bad, and then redirects the data to a different
block.

Read Request Hot Fix Redirection

This hot fix occurs when a disk error takes place during a read request. If the hard
disk is mirrored, the operating system retrieves the data from the mirrored disk, and
then redirects the data on the primary disk. If the hard disk is not mirrored the data is
lost, but the block is marked as bad so that future data will not be stored there.

Read After-Write-Verification Hot fix Redirection

This hot fix occurs after the data is written to disk. The data on disk is then read and
compared to that in the memory. If the two do not match, the operating system
marks the block as bad, and redirects the data to a different block.
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Figure 7. 15 - Disk SET Parameters

Enable Disk Read After Write Verify

This parameter controls whether data written to disk is compared with memory.
Normally this parameter is ON. If you need extra disk speed on writes and your
disks are reliable and mirrored, setting this parameter to OFF can nearly double your
disk speed.

Limits: ON or OFF

Default: ON

Concurrent Mirror Requests

This parameter sets the number of re-mirror requests per logical partition.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: 2 to 30

Default: 4
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Miscellaneous Set Parameters Dialog Box

The Miscellaneous SET parameters dialog box (Figure 7.16) controls:

• Encrypted passwords

• Alerts

• NCP searches

• Server processes

Figure 7. 16 - Miscellaneous SET Parameters

Allow Unencrypted Passwords

This parameter controls the use of unencrypted passwords.

Considerations

If set to ON, users are allowed to use both encrypted and unencrypted passwords.

If set to OFF, users may use only encrypted passwords.

NOTE:  In order to set this parameter to OFF on a network that has file servers
running NetWare v2.12 and above, but none running v2.0a, you must copy the
NetWare v3.1x utilities to these file servers.

If all file servers are running NetWare v3.1x, set to OFF.
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If there are file servers running NetWare v2.0a, set to ON.

Limits: ON or OFF

Default: OFF

Display Spurious Interrupt Alerts

This parameter controls display of spurious interrupt alert messages.

Considerations

A message is sent to the file server console whenever the hardware in the file server
creates an interrupt that has been defined and reserved for another device.

Spurious interrupts generate the following type of message:

Spurious hardware interrupt <number> detected

NOTE:  Spurious interrupt message indicates a serious error in the hardware.

If your file server console displays spurious interrupt messages:

Remove all add-on boards and run SERVER.

If the message does not appear, add the boards one at a time until you have
discovered which piece of hardware is creating the spurious interrupt.

Contact the vender of hardware causing the problem. Set this parameter to OFF
while you are waiting for a resolution.

Limits: ON or OFF

Default: ON

Display Lost Interrupt Alert

This parameter controls the display of lost interrupt messages.
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Considerations

If an interrupt request from a driver or board is dropped before the CPU is able to
respond to the request, the following message is generated:

Interrupt controller detected a lost hardware interrupt

This message indicates a hardware or driver problem which may degrade system
performance.

If your file server console displays lost interrupt messages:

• Unload all drivers.

• Reload them one at a time to determine which driver is causing the problem.

• Contact the vender of driver causing the problem. Set this parameter to OFF
while you are waiting for a resolution.

Limits: ON or OFF

Default: ON

Display Disk Device Alerts

This parameter controls the display of hard disk informational messages.

Considerations

If set to ON, a message is generated every time a hard disk is added, activated,
deactivated, mounted, or dismounted.

Set to OFF if you are not experiencing hard disk problems.

Limits: ON or OFF

Default: OFF

Display Relinquish Control Alerts

This parameter controls the display of CPU control messages. If an NLM uses the
CPU for more than .4 seconds without releasing control to other processes, a control
alert message is generated.
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Considerations

Set to ON only if you are writing your own NLMs.

Limits: ON or OFF

Default: OFF

Display Incomplete IPX Packet Alerts

This parameter controls messages about IPX alerts.

Considerations

If set to ON, displays alert messages when the IPX receives incomplete packets.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the amount of memory allocated to the "Alloc Memory Pool."

Limits: ON and OFF

Default: ON

Display OLD API Names

This parameter controls the display of old NetWare v3.0 API calls. NetWare 3.1x
renamed some of the APIs as additional resources were tracked. The old APIs work,
but more slowly than the new APIs.

Considerations

Set to ON if you are writing your own NLMs and are upgrading NetWare 3.0 NLMs
to new 3.1x APIs. Set to OFF if no v3.0 NLMs are being upgraded to NetWare 3.1x
APIs. If you are receiving these messages, contact the vendor of the module
generating these messages.

Limits: ON or OFF

Default: OFF
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Maximum Outstanding NCP Searches

This parameter sets the maximum number of NetWare Core Protocol (NCP)
directory searches that may be processed at the same time.

Considerations

Under normal conditions, only one NCP directory search occurs at a time.

Increase this parameter only if you are using applications that support multiple
directory search operations simultaneously, and you are having problems with
corrupted or invalid directory information.

Limits: 10 to 1000

Default: 51

New Service Process Wait Time

This parameter sets the length of time that the operating system waits to make the
allocation after receiving a request for another service process.

Limits: 0.3 seconds to 20 seconds

Default: 2.2 seconds

 Pseudo Preemption Time

This parameter sets the amount of time available for certain NLMs to keep an NLM
process from using too much CPU time.

Considerations

Set only as your NLM documentation recommends.

Limits: 1000 to 10000 (Raw CPU time,
approximately .84 seconds each)

Default: 2000
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 Maximum Service Processors

This parameter sets the maximum number of service processes that the operating
system may create.

Considerations

Increase this parameter if the number of currently allocated service processes is at
the maximum. Increasing this parameter will only help if more than 20 requests are
being delayed simultaneously for a disk I/O to be completed.

Temporarily decrease this parameter if the file server is low on memory. Add
memory if the file server is always low on memory.

NOTE:  Before changing this parameter, use NetWare’s MONITOR.NLM or
NetTune to view the number of service processes that have currently been allocated.

Limits: 5 to 40

Default: 20

 Replace Console Prompt with Server Name

This parameter replaces the console prompt of “:” with the file server name.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: ON or OFF

Default: ON

 Allow Change To Client Rights

This parameter allows the client rights to be changed.

This command applies only to NetWare version 3.12 users. NetWare version 3.11
users will not see this parameter displayed in the Communications dialog box.

Limits: ON or OFF

Default: ON
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Time Tune Command
The Time Tune command is used to create, schedule, or disable Tune Jobs through
the Time Tune dialog box (Figure 7.17). A Tune Job is the scheduling or
unscheduling of a Tune file.

Figure 7. 17 - Time Tune Dialog Box

As discussed in Chapter 4, NetTune has the ability to schedule predefined files
called "Tune" files to run unattended at specific times. These files contain unique
SET parameters for changing the file server configuration. Tune files must have a
.NTT file extension and must be located in the SYS: volumes SYSTEM directory.

The Time Tune dialog box consists of the following components:

Time Tune Job List Window

The Time Tune Job List window (Figure 7.18) displays information on all existing
Time Tune files that will run on the server. It displays the following components:
Tune file’s job name, status (if it’s disabled or not), frequency rate (if the Job runs
daily, weekly, or monthly), the time the Tune job will begin running, and the Tune
file name.

Figure 7. 18 - Time Tune Job List Window
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Servers selection box

The Servers selection box (Figure 7.19) allows you to select the file server that
contains the Tune file(s) you wish to schedule as Tune jobs. Click on the group icon
to display and select from the server list.

Figure 7. 19 - Servers Selection Box

Tune Files selection box

The Tune Files selection box (Figure 7.20) is used to select Tune files you wish to
schedule as Tune jobs. When you have selected the appropriate server you will see a
list of that server’s Tune files. Specific files can be selected via mouse clicks.

Figure 7. 20 - Tune Files Selection Box

Job Disable Check Box

This check box is used to temporarily enable or disable a Tune file. To disable a job
from running, place an X in the check box.

Job Name Text Box

Enter up to 16 characters in this box to name a Tune job.

Frequency Radio Button

This Frequency radio button (Figure 7.21) is used to select the Tune job’s frequency
(when the Tune job will run). SmartTune can schedule Tune jobs on a daily, weekly,
or monthly frequency rate. To select a frequency just click on the left mouse button.
If you select Daily, you will be able to adjust the Hours, Minutes, and Seconds. The
Day of Month selection box and the Day of Week selection box will not be
selectable. Table 7.2 shows the active selection boxes for the three frequencies.
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Figure 7. 21 - Frequency Radio Buttons

Radio Button Active Selection Box

Daily Hours, Minutes, and Seconds

Weekly Day of Week, Hours, Minutes, and
Seconds

Monthly Day of Month, Hours, Minutes, and
Seconds

Table 7.2 - Table of Active Selections for Radio Buttons

Day of Week Pull-Down Selection Box

When the Weekly Frequency radio button is selected, the Day of Week selection
box becomes active. Click on the down arrow to see your choices. A pull-down list
will appear with all seven days of the week. Select the appropriate day you wish to
activate your Tune job.

Day of Month Selection Box

When the Monthly Frequency radio button is selected, the Day of Month selection
box becomes active. Click on the up and down arrows to see your choices. Select the
appropriate day of the month you wish to activate your Tune job.

Time Selection Box

Whenever the Daily, Weekly, or Monthly Frequency radio button is selected, the
Time selection box becomes active. You can click on the up and down arrow to see
your choices. Select the appropriate hour, minute, and second of the day you wish to
activate your Tune job.
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The SmartTune Activity dialog box includes push buttons. Table 7.3 describes the
function of each push button.

Delete The Delete button is used to delete the highlighted
tune job in the job list.

Save The Save button will save the current Tune file
schedule

Help The Help button will bring up NetTune’s Help
index.

Close The Close button ends the session without saving
any changes.

Table 7.3 - Table of SmartTune’s Push Buttons for the Time Tune

SmartTune Command
SmartTune’s sophisticated artificial intelligence is able to automatically adjust SET
parameters on the fly, based on real-time data collected.

As SmartTune detects changes in real-time, it will make changes accordingly, giving
maximum optimization for your server. This optimization helps by eliminating
bottlenecks or potential dangers associated with pushing the envelope on your
operating system. The primary advantage of the SmartTune module is providing
optimization while you carry on with administration duties without having to worry
about manually adjusting parameters.

Each of the four SmartTune dialog boxes has the same look and feel, as an Options
selection box, a Servers selection box, and a Print Topic check box.

Options Selection Box

The Options selection box, located at the top left of the SmartTune dialog box
(Figure 7.22), allows you to select four different options for SmartTune:

• Tuning Options (Section 7.3.1)

• Quick Analysis (Section 7.3.2)

• Activity Log (Section 7.3.3)

• Performance Indicators (Section 7.3.4)
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Figure 7. 22 - Options Selection Box

Servers Selection Box

The Servers selection box, located at the bottom left of the SmartTune dialog box
(Figure 7.23), allows you to select a preferred file server.

Figure 7. 23 - Servers Window

To select a file server:

1. Double click on the group icon to expand the Group list into the Server list.

2. Click on the desired server.

Printer Check Box

The Printer check box, located at the top right of the SmartTune dialog box, allows
you to select multiple topics for printing.

To select a topic for a Print Report:

1. Highlight the topic from the Options selection box to be included in the Print
Report.

2. Mark the Printer check box with an X by clicking on the left mouse button. This
indicates that the current option will be part of the Print Report.

3. If you need to include other options into the Print Report, continue from Step 1.

4. Click on the Print Report button at bottom of the SmartTune dialog box to begin
printing the report.



Chapter 7:  Tune  Menu Introdudtion 107

To de-select a topic from a Print Report:

1. Highlight the topic to be removed from the Print Report from the Options
selection box.

2. Remove the X from the Printer check box by placing the mouse cursor over
check box and click on the left mouse button. This indicates that the current
option will not be part of the Print Report.

3. If you need to de-select other options from the Print Report, then continue from
Step 1.

SmartTune Tuning Options

SmartTune automatically adjusts SET parameters on the fly, even those that could
only be modified in the server’s NCF files. The adjustments are based on complex
decisions made by the software’s artificial intelligence from data that is collected
every second.

The SmartTune Tuning Options dialog box has a Tuning Options window (Figure
7.24).

Figure 7. 24 - SmartTune Tuning Options Dialog Box

To use the Tuning Options window select the desired server from the Servers
selection box.

In the Tuning Options window you will see a Server Environment selection box and
a number of server check boxes.
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The Server Environment selection box contains the following environments:

• Non-Specific

• Backup

• Database

• Word Processing

• Read Intensive

• Write Intensive

• Software Development

Select the environment that best suits your network environment. Once the desired
environment has been established, you need to mark the Enable SmartTune
(Automatic Tuning) check box to ON by clicking the check box. This will place an
X in the check box and enable SmartTune. When this is done, click on the Set
button to save your choices, and then click on the Close button to exit.

In some cases you may not require SmartTune to adjust all the SET parameters for
your specific environment. In this case you should click on the Enable SmartTune
(Automatic Tuning) to activate SmartTune. Next, click on the check boxes that best
identify the areas that need SET parameter modification.

Following is a list of the additional check boxes:

• Optimize File Cache

• Optimize Disk I/O

• Optimize Directory Cache

• Optimize Turbo FAT

• Optimize Packet Receive Buffers

• Optimize Service Processes

You can select as many of these fields as you like as long as you enable the Enable
SmartTune (Automatic Tuning) check box. Smart Tuning will not take place if the
check box is not activated. When this is done, click on the Set button to save your
choices, and then click on the Close button to exit.

Those who prefer that SmartTune handle all aspects of optimizing the network
server may select Non-Specific from their Server Environment, and click on the
Enable SmartTune (Automatic Tuning) check box. When this is done click on the
Set button to save the choices, and then click on the Close button to exit.
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If you no longer wish to have SmartTune tune the selected server, click on the
Enable SmartTune (Automatic Tuning) check box. This will remove the X from the
check box and disable SmartTune.

Click on Set to save your settings.

The SmartTune Tuning Options dialog box includes push buttons. Table 7.4
describes the function of each push button.

Set The Set button will save your SmartTune
choices.

Refresh The Refresh button will refresh the CRT
screen display.

Print
Report

The Print Report button will print out a report
of all previously selected categories.

Print Topic The Print Topic button will print out the
currently selected topic.

Help The Help button will bring up NetTune’s Help
Index.

Close The Close button will end the session and
quit.

Table 7.4 - Table of SmartTune’s Push Buttons for the Tuning Options

SmartTune Quick Analysis

The Quick Analysis dialog box (Figure 7.25) provides a variety of information and
recommendations on your selected file server. In the Quick Analysis window you
will find three fields: the Show selection box, the Results and Recommendations
dialog box, and the Background dialog box.
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Figure 7. 25 - SmartTune Quick Analysis Dialog Box

The Show selection box includes three radio buttons. Which radio button you select
will determine what information is displayed in the Results and Recommendations,
and Background dialog boxes.

SmartTune’s Quick Analysis runs two sets of pass/fail diagnostics on the server’s
SET parameters. Either they pass or they fail.

SmartTune’s Show selection box defaults to Recommendations Only. This will
show the results of all diagnostics that have failed. These results (and their
recommendations) will be displayed in the Results and Recommendations dialog
box. The Background dialog box will include a brief description of the
recommendation.

The Succeeded Only radio button will display only the diagnostics that passed the
diagnostic test. In the Results and Recommendations dialog box you will see a
listing of all the server’s SET parameters that are OK. The Background dialog box
will also display a brief description of why these SET parameters are OK.

If you choose to see all the results, whether they pass or fail, select the All Results
radio button. This will display all the successes and failures found with the selected
server’s SET parameters. The Background dialog box will also display a brief
description of why these SET parameters are good or bad.
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The SmartTune Quick Analysis dialog box includes push buttons. Table 7.5
describes the function of each push button.

Accept The Accept button will accept any
recommendations for diagnostics that
have failed.

Refresh The Refresh button will rerun the
diagnostics and refresh the display.

Print Report The Print Report button will print out all
previously selected categories.

Print Topic The Print Topic button will print out the
currently selected topic.

Help The Help button will bring up NetTune’s
Help Index.

Close The Close button will quit your session
and exit.

Table 7.5 - Table of SmartTune’s Push Buttons for the Quick Analysis

SmartTune Activity Log

The SmartTune Activity Log (Figure 7.26) provides a comprehensive log file of all
NetWare activity that occurred while the SmartTune NLM was loaded.

Figure 7. 26 - SmartTune Activity Log Dialog Box
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This information collected from the server is stored in a activity log file called
NT$LOG.NTD. This file is stored in the SYSTEM directory on the server’s SYS
volume.

The SmartTune Activity dialog box includes push buttons. Table 7.6 describes the
function of each push button.

Clear The Clear button will clear out the activity
log.

Refresh The Refresh button will refresh the screen’s
display.

Print Report The Print Report will print out all previously
selected categories.

Print Topic The Print Topic will print out the currently
selected topic.

Help The Help button will bring up NetTune’s
Help Index.

Close The Close button will end your session and
exit.

Table 7.6 - Table of SmartTune’s Push Buttons for the Activity Log

SmartTune Performance Indicators

The Performance Indicators option (located in the Options selection box) displays
real-time activity on your selected server that most affects NetWare performance
(Figure 7.27).
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Figure 7. 27 - SmartTune Performance Indicators Dialog Box

From this dialog box you can select your preferred file server from the Servers
selection box, located at the bottom left of the screen.

Performance Indicators Window

Once the preferred server is selected, the performance indicators will begin
displaying the percentage of real-time activity for the following categories:

• Server Utilization

• Dirty Cache Buffers

• Current Disk Requests

• Service Processes

• Packet Receive Buffers

• Directory Cache Buffers

• Percent of Volume Purgeable

• Connections in Use

• Cache Hit Ratio

• Read\Write Ratio
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• The Performance Indicators will display in three different colors. See table 7.7
for the color representation.

Red Indicates SET parameters require investigation
or possible action.

Green Indicates everything is OK.

Yellow Indicates SET parameters may require
investigation but do not require any action.

Table 7.7 - Color Representation for Performance Indicators

The SmartTune Performance Indicators dialog box includes push buttons. Table 7.8
below describes the function of each push button.

Refresh Updates the CRT screen with current output
data.

Print
Report

Prints all of the previously selected categories.

Print Topic Prints the currently selected category.

Help Opens the NetTune Help index.

Close Ends your session and exits.

Table 7.8 - Table of SmartTune’s Push Buttons for the Performance Indicators
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Chapter 8 Information Menu Introduction

The Information menu supplies you with the following data:

• File server configuration

• NLMs loaded

• Current SET parameter values

• Connections summary

Server Configuration Command
Use the Server Configuration pull-down menu to quickly check the server’s
configuration.

Figure 8. 28 - Information Pull-Down Menu

From the Server Configuration dialog select any server in the Server’s selection box.
Detailed server configuration statistics and information will become accessible for
that selected server. The data fields are updated every five seconds.

The following options are available:
• NetWare information

• LAN Information

• Connection Information

• Volumes Information

• NLMs Loaded, Versions and Description Information

• Set Parameters Values

• Historical Information
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Printing Configuration Topics and Reports

Any of the configuration information items located in the Information selection box
can be printed.

• Print Report will print out a group of previously selected information items.

• Print Topic will print the currently highlighted information item in the
Information selection box.

Printing a Report

To print multiple topics for a report use Print Report:

1. Highlight a topic in the Information selection box and click the left mouse
button once (Figure 8.29).

Figure 8. 29 - Information Selection Box

2. Click on the Printer check box to mark your selection for a multiple item Print
Report.

Selecting an item places an X in the Printer check box (Figure 8.30). The Printer
check box is located at the top right side of the dialog box.

Figure 8. 30 - Selecting an Item for a Report

3. Repeat this process from step one if you have additional items to include in your
information report.

4. When you have finished making item selections, click on the Print Report
button to begin printing (Figure 8.31).

Figure 8. 31 - Print Report Button
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Printing a Topic

To print a single information item:

1. Highlight a topic in the Information selection box and click the left mouse
button (Figure 8.32).

Figure 8. 32s - Information Selection Box

2. Click on the Print Topic button to begin printing (Figure 8.33).

Figure 8. 33 - Print Topic Button

Selecting Servers from the Desktop or Groups

The Server Configuration dialog box allows you to select specific file servers for
viewing configuration information. The Servers’ selection box, located at the bottom
left of the Server Configuration dialog box, displays icons representing groups that
contain file servers.

NetTune’s default group is called Desktop (Figure 8.34).

Figure 8. 34 - NetTune’s Default Group
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The Desktop may contain a single file server or many file servers depending on the
following conditions:

• How many file servers have the NetTune NLM loaded.

• How many of the above mentioned file servers have been added to the Desktop
group.

Any file server(s) added to a group after the NLM installation will display an icon
with the file server name in a list tree for that group.

To view the list tree containing the server’s icon and name, double-click on the
group icon. This will expand the group into a list tree that will display all the file
servers associated with that particular group.

To close a list tree, double-click on the corresponding group icon.

Any additional groups you create will also display in the Servers’ selection box
(Figure 8.35).

Click on any group icon to expand the group’s internal tree and display a list of all
file servers associated with that group.

Figure 8. 35 - Servers’ Selection Box Containing Multiple Groups

Reporting NetWare Version Information

To report NetWare version information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Choose a file server from the Servers’ pull-down menu.

3. Select NetWare from the Information pull-down menu to open the NetWare
dialog box (Figure 8.36).
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Figure 8. 36 - NetWare Dialog Box

Reporting LAN Information

To report LAN information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Click on the LAN option in the Information selection box (top left of the screen)
to open the LAN dialog box (Figure 8.37).

Figure 8. 37 - LAN Dialog Box
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Reporting Connection Information

To report server Connection (login) information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Choose a file server from the Servers’ pull-down menu.

3. Click on the Connections option in the Information selection box (top left of the
screen) to open the Connections dialog box (Figure 8.38).

Figure 8. 38 - Connection Dialog Box

Reporting Volume Information

To report Volume information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Choose a file server from the Servers’ pull-down menu.

3. Click on the Volumes option in the Information selection box (top left of the
screen) to open the Volumes dialog box (Figure 8.39).
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Figure 8. 39 - Volume Dialog Box

Reporting NLM Information

To report NLMs loaded, version and description information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Choose a file server from the Servers’ pull-down menu.

3. Click on the NLMs option in the Information selection box (top left of the
screen) to open the NLM dialog box (Figure 8.40).

Figure 8. 40 - NLM Dialog Box
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Reporting SET Parameters Information

To report active SET parameters range information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Choose a file server from the Servers’ pull-down menu.

3. Click on the Set Parameters option in the Information selection box (top left of
the screen) to open the SET Parameters dialog box (Figure 8.41).

Figure 8. 41 - SET Parameter Dialog Box

Reporting NetTune Information

To report NetTune information:

1. Select the Server Configuration command from the Information pull-down
menu.

2. Choose a file server from the Servers’ pull-down menu.

3. Click on the NetTune option in the Information selection box (top left of the
screen) to open the NetTune dialog box (Figure 8.42).
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Figure 8. 42 - NetTune Dialog Box

NLMs Loaded Command
The NLMs Loaded command reports the following specific NLM information to the
screen:

• Name

• Code size

• Data size

• Total size

• Version

• Date

• Description

To report information on loaded NLMs:

1. Select NLMs Loaded from the Information pull-down menu.

Figure 8. 43 - Information Pull-Down Menu
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2. Review the NLM Information Report list box (Figure 8.44).

Figure 8. 44 - NLM Information Report

3. To print the NLM Information Report, click on the Printer icon.

4. To copy the information to the clipboard, click on the Copy icon.

SET Parameter Values Command
The SET Parameters Values command reports the following SET Parameter
information:

• SET Parameter name

• Current value

• SET Parameter range

To report SET Parameter Values:

1. Select SET Parameter Values from the Information pull-down menu (Figure
8.45).

Figure 8. 45 - Information Pull-Down Menu
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2. Review the Set Parameters Information Report.

Figure 8. 46 - SET Parameters Information Report

3. To print the SET Parameter Values, click on the Printer icon.

4. To copy the information to the clipboard, click on the Copy icon.

Connections Summary Command
The Connections Summary command is used to display or print a report containing
the following Connection information:

• Connection number

• Login name

• Number of minutes connected

• Total NCP requests

• Total bytes read

• Total bytes written

• Network address
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To report connection information:

1. Select Connections Summary from the Information pull-down menu (Figure
8.47).

Figure 8.47 - Information Pull-Down Menu, Connections Summary Option

The Connections Summary Information Report will appear (Figure
8.48).

Figure 8. 48 - Connections Summary Information Report

2. To print the Connection Information, click on the Printer icon.

3. To copy the information to the clipboard, click on the Copy icon.
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Chapter 9 Statistics Menu Introduction

The Statistics menu provides pre-defined graphs and reports on all aspects of
NetWare statistics. You can use the default graphs and reports as is, customize them,
or create new graphs and reports. In addition, recording intervals and durations can
be adjusted to control the frequency and time frame of collected data.

Figure 9. 49 - The Statistics Pull-Down Menu

Graphed charts display file server activity over a specified period of time.

Any graph can be changed to another style (2D, 3D, Pie, Line, etc.) by selecting the
Graphs Option icon (Figure 9.2) from the Toolbar menu, or by selecting the
Customize command from the Statistics’ pull-down menu.

Figure 9. 50 - Graph Option Icon

See Chapter 9.11. for information on how to customize graph and text reports.
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Network Statistics
View a Network Statistics’ graph by selecting the Network command from the
Statistics’ pull-down menu. The displayed graph (Figure 9.5) shows the amount of
packet activity over the network for a specific period of time.

Network activity is displayed in three statistics:

• Packets Received

• Packets Transmitted

• Packets Routed

Figure 9. 51 - Network Statistics Dialog Box
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Disk Statistics
View a Disk Statistics’ graph by selecting the Disk command from the Statistics’
pull-down menu. The displayed graph (Figure 9.6) shows the amount of disk
activity for a specific period of time.

Disk activity is displayed in three statistics:

• Disk Reads

• Disk Writes

• Disk Requests

Figure 9. 52 - Disk Statistics Dialog Box
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Connection Statistics
View a Connection Statistics’ graph by selecting the Connection command from the
Statistics’ pull-down menu. The displayed graph (Figure 9.7) shows the amount of
connection activity on the server for a specific period of time.

Connection activity is for stations connected.

Figure 9. 53 - Connection Statistics Dialog Box
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Utilization Statistics
View a Utilization Statistics’ graph by selecting the Utilization command from the
Statistics’ pull-down menu. The displayed graph (Figure 9.8) shows the amount of
CPU Utilization activity on the server for a specific period of time.

Utilization is displayed as a CPU percentage.

Figure 9. 54 - Utilization Statistics Dialog Box



132 Using NetTune

Volume Statistics
View a Volume Statistics’ graph by selecting the Volume command from the
Statistics’ pull-down menu. The graph (Figure 9.9) displays the amount of Volume
Statistics for a specific period of time.

Volume Statistics is broken down into four parts:

• Used

• Available

• Purgeable

• Not Yet Purgeable

Figure 9. 55 - Volume Statistics Dialog Box
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LAN Segments Statistics
View a LAN Segment Statistics’ graph by selecting the LAN Segments command
from the Statistics’ pull-down menu. The graph (Figure 9.10) displays the amount of
LAN Segment activity over the Network for a specific period of time.

LAN Segment activity is broken down into Total Packet for a LAN Adapter.

Figure 9. 56 - LAN Segments Statistics Dialog Box

The representation of Total Packets for a LAN Adapter will depend on the number
of LAN adapters installed in the file server. Each LAN adapter is represented by a
different color in the Legend.
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Memory Statistics
View a Memory Statistics’ graph by selecting the Memory command from the
Statistics’ pull-down menu. The graph (Figure 9.11) displays the amount of Memory
activity for a specific period of time.

Memory is displayed in five parts:

• Cache memory

• Permanent memory

• Allocated memory

• Movable memory

• Non-movable memory

Figure 9. 57 - Memory Statistics Dialog Box
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Free Space Statistics
You can view a Free Space Statistics’ graph by selecting the Free Space command
from the Statistics’ pull-down menu. The graph (Figure 9.12) displays the amount of
Free Space for a specific period of time.

Figure 9. 58 - Free Space Statistics Dialog Box

Each color on the Graph represents a volume on that server.
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Read Ratio Statistics
View a Read Ratio Statistics’ graph by selecting the Read Ratio command from the
Statistics’ pull-down menu. The graph (Figure 9.13) displays an approximate Cache
Hit Ratio for Read activity over a specific period of time.

Read Ratio activity is broken down into two parts:

• Disk Reads

• File Reads

Figure 9. 59 - Read Ratio Statistics Dialog Box
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Cache Buffers Statistics
View a Cache Buffer Statistics’ graph by selecting Cache Buffer command from the
Statistics’ pull-down menu. The graph (Figure 9.14) displays the Cache Buffer
Statistics for a specific period of time.

Cache Buffer Statistics are displayed in four parts:

• Current Cache Buffers

• Directory Cache Buffers

• Receive Cache Buffers

• Dirty Cache Buffers

Figure 9. 60 - Cache Buffer Statistics Dialog Box
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Customize Command
NetTune enables you to create custom report/graphs from predefined reports. After
opening one of the Statistics menu predefined statistical reports, the Customize
command is used to modify and create a new report/graph.

After you create a new report/graph, you can name it, save it, and use it to run the
report at any time.

Creating a Custom Report

To create a custom report:

1. First, select a predefined report to modify.

2. Next, select the Statistics’ pull-down menu and choose the Customize
command.

Figure 9.61 - Statistics Pull-Down Menu

The Customize Reporting dialog box will appear (Figure 9. 16). This
dialog box contains many options for customizing reports to your
specific requirements.
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Figure 9. 62 - Customize Reporting Dialog Box

Customize Reporting Dialog Box

This section contains a functional description of the check boxes, list boxes, and
command push buttons found in the Customize Reporting dialog box.

Report Type Option Buttons

These buttons represent a group of mutually exclusive report options. You can select
only one option at a time. The selected options button contains a black dot.

Button Function

Realtime Create a report and update in real-
time.

Short-Term
History

Use the short-term history database.

Long-Term
History

Use the long-term history database.

Previous Check Box

This check box is used to view recorded data for the previous time period specified
in the Time Range boxes. This option is not available for Realtime Report Type.
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Range Option Buttons

These buttons represent a group of mutually exclusive report range options. The
selected option is used to determine the range of historical data to be displayed. You
can select only one option at a time. The selected options button contains a black
dot.

Button Function

Day Display server data for the last full day.

Week Display server data for the last seven
days.

Month Display server data for the last month.

Quarter Display server data for the last three
months.

All Display all daily server data.

By selecting one of these options, the start and end date times are automatically
adjusted. You can then manipulate the start and end dates manually.

Output Option Buttons

These buttons represent a group of mutually exclusive report output form and
destination options. You can select only one option at a time. The selected options
button contains a black dot.

Button Function

Comma Delimited
File

Outputs the server collected historical
data to a comma delimited ASCII.

ASCII Test File Outputs the server collected historical
data to an ASCII file.

Text Screen\Print Outputs the server collected historical
data as a text report to the screen or
printer.

Graph Screen\Print Outputs the server collected historical
data as a graph report to the screen or
printer.
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Time Range Selection Boxes

These selection boxes are used to determine the beginning and ending time ranges of
displayed historical data.

In order to avoid plotting incorrect data, time ranges must not exceed start and finish
dates for Long-Term and Short-Term History database files.

Time range parameters can be used to display a desired interval of data from the
database.

Display Interval Selection Boxes

These selection boxes are used to determine the historical data graph time range
gradients.

Statistical Classes List Box

This box displays a list of statistical class choices.
Use the Statistical Classes’ list box to select network categories for creating graphs
and custom reports.

Statistical Classes are the areas of NetWare interest, including Cache, Connections,
Utilization, Disk Activity, FAT, Memory Pools, Processor, etc.

To select all Class Data Items associated with the current selection, click on the Add
All command push button.

Class Data Items List Box

This box displays the Class Data Items associated with the selected Statistical Class
topic.

To select individual Class Data Items, click on your choices. To add your selections
to the graph or report, click on the Add button.

If you would like your graph to include all Class Data Items in the list box, click on
the Add All button.

If you select Disk Total for the Statistical Class, it will show you Disk Read and
Disk Write totals for the data items in that Statistical Class.

Selected Data List Box

This box displays the Class Data Items you selected for your custom graph or report.

To remove Class Data Items, click on your choices, and then click on the Remove
command push button.
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The Customize Reporting dialog box also contains the following command push
buttons (Figure 9.16):

Button Function

OK Accept current changes and exit the
Customize Reporting dialog box.

Cancel Exit the Customize Reporting dialog box
without saving any changes.

Help Open the NetTune Help Index.

File When you select a Comma Delimited or
ASCII Text file, this button becomes
selectable. Click it on to enter a name for
your file.

Graph Open the Graph Options dialog box.

Add All Add all Class Data Items associated with the
selected Statistical Class to the graph or
report.
Display selections in the Selected Data list
box.

Add Add individual item from the Class Data
Items list box to the graph or report.
Display selections in the Selected Data list
box.

Remove Remove the highlighted Class Data Item
from the Selected Data list box and the graph
or report.
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Graph Options Dialog Box

Selecting the Graph button from the Customize Reporting dialog box opens the
Graph Options dialog box (Figure 9.17).

Figure 9. 63 - Graph Options Dialog Box

Following is a functional description of the check, list, selection, and text boxes
found in the Customize Reporting dialog box (Figure 9.17).

Graph Type

This list box is used to select the type of graph or chart used to represent server data.

Graph Style

This list box contains all graphing options associated with the currently selected
Graph Type. Options will vary depending on the Graph Type selected.

Graph Title

Each graph that you create can be assigned a title. The Graph Title check box
enables or disables the title display.
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Use the text box next to the Graph Title check box to enter a new graph title.

X Axis

The X Axis selection box controls the horizontal coordinates for the graph (Figure
9.17).

Option Function

Title This check box is used to enabled the X
axis title display.
If empty, the title will not display.

Axis on Top This check box is used to display the X
axis on the top of the screen instead of
the bottom.
If empty, the X axis appears at the
bottom of the screen.

Variable Orgins This check box is used to isolate a
portion of a large graph in order to
closely examine a smaller portion of the
graph.
Variable Origin will not work with
Stacked Graph Styles.

Data This box is used to specify the number
of data points to display on each page.

Label This box is used to specify X axis
domain labeling intervals.

Tick Every This box is used to specify the X axis
domain tick mark intervals.
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Y Axis Section

The Y Axis selection box controls the vertical coordinates for the graph (Figure
9.17).

Option Function

Title This check box is used to enabled the Y
axis title display.
If empty, the title will not display.

Axis on Right This check box is used to display the Y
axis on the right side of the screen.

Variable Orgins This check box is used to isolate a portion
of a large graph in order to closely
examine a smaller portion of the graph.
Variable Origin will not work with
Stacked Graph Styles.

Labels This check box is used to remove Y axis
range labels. This option creates more
room to display multiple data graphs.

Tick Every This box is used to specify the number of
tick marks that will display on the Y axis.
The NetTune default value is five.

Maximum This box is used to specify the maximum
value to be graphed. If this value is set to
zero, the value defaults to auto scale
mode.

Minimum This box is used to specify the minimum
value to be graphed. If this value is set to
zero, the value defaults to auto scale
mode.



146 Using NetTune

Miscellaneous Selection Box

This section of the Graph Options dialog box (Figure 9.17) contains a number of
custom settings.

Option Function

Hot Spots This check box enables the Graph feature
to pop-up text values.

Patterns When activated this check box fills data
blocks with patterns representing
different graph colors. This is useful for
printing graphs with a gray scale printer.

Legends This check box enables the legend for
your custom graph.

Statistics
(line type only)

Selecting a line graph from the Graph
Type list box activates the Statistics (Line
Type) list box.
This list box displays statistical graphing
options for line graphs.

Displaying a Custom Graph/Report

After setting all the custom graph options, click on the OK command push button
(Figure 9.17) to return to the Customize Reporting dialog box.

Click on the OK button from the Customize Reporting dialog box (Figure 9.16) to
display your custom graph/report.
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Save Custom Command
The Save Custom command is used to accomplish the following actions:

• Save a custom report

• Delete a custom report

• Update an existing custom report

• Rename a custom report

Saving a Customized Report:

1. After creating a custom graph/report, highlight it and choose Save Custom from
the Statistics’ pull-down menu (Figure 9.20).

Figure 9. 64 - Statistics Pull-Down Menu

2. When the User Custom Reports dialog box appears (Figure 9.21), click on the
Save button.

Figure 9. 65 - User Custom Reports Dialog Box
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3. After the Report Name dialog box appears (Figure 9.22), enter a short
descriptive name for your custom report and click on the OK button.

Figure 9. 66 - Name Dialog Box

4. After the User Custom dialog box appears (Figure 9.23), click on the Close
button to end the session.

Figure 9. 67 - User Custom Reports Dialog Box

4. Upon returning to the Statistics’ pull-down menu, notice that the custom report
appears in the Statistics’ pull-down menu (Figure 9.24).

Figure 9. 68 - Viewing the Custom Report
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Updating, Deleting, and Renaming Custom Reports

To update, delete, or rename a custom report:

1. Select the Save Custom command from the Statistics’ pull-down menu (Figure
9.25).

Figure 9. 69 - Statistics Pull-Down Menu

When the User Custom Reports dialog box appears (Figure 9. 26),
existing custom report names are displayed in the Reports’ list box.

Figure 9. 70 - User Custom Reports Dialog Box

2. Click on a custom report name in the Reports’ list box.

3. Click on either the Update, Delete, or Rename command button to initiate the
desired action.

4. Click on the Close button to end the session.
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Recording Intervals Command
To take full advantage of NetTune, it is recommended that you set up the preferred
historical recording intervals before you install the NLM software. Once the NLM
software is installed and loaded, it immediately begins collecting data based on the
NetTune default recording intervals defined at the time of install (see the following
table).

Default Times for Interval and Duration

Interval Duration

Real Time 5 seconds 3 minutes

Short Term 5 seconds 24 hours

Long Term 5 minutes 90 days

If the supplied default values are not sufficient, change to time intervals and
durations that are more appropriate.

The historical recording intervals use two variables to allow NetTune to collect and
record data.

The two user-defined variables are Recording Interval and Recording Duration.

• The Recording Interval defines how often NetTune collects or records data.

• The Recording Duration specifies the maximum time the data will be kept.

NetTune’s NLM keeps three historical records of server activity:

NT$HIST0.NTD This file contains short-term recording
interval information. When this file
reaches its maximum size (defined by the
Recording Duration), it will purge the
oldest data in the file.

NT$HIST1.NTD This file contains long-term recording
interval information. When this file
reaches its maximum size (defined by the
Recording Duration), it will purge the
oldest data in the file.

Real-Time
Memory File

An in-memory file containing the real-
time statistics.
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Changing Recording Interval and Duration

To set preferred historical recording intervals:

1. Select the Recording Intervals command from the Statistics pull-down menu
(Figure 9.27).

Figure 9. 71 - Statistics Pull-Down Menu

2. When the Recording Intervals dialog box appears (Figure 9.72), specify a
Recording Duration time. This defines a specific time period in which server
data will be collected.

Also, specify a collection time called Recording Interval. This defines how
many times during the specified duration NetTune’s NLM collects server data.

Figure 9. 72 - Recording Interval Dialog Box

3. Click on the Close button when finished.
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Record Interval Database Files

The Maximum Size and Current Size fields (found in the Recording Interval dialog
box under Current Recording Interval for Selected Server, figure 9.72), are the sizes
of the Recording Interval data base files.
These files are created when a Recording Interval or Recording Duration time is
supplied for Real-Time, Short Term, or Long Term data collection (see the following
table).

Recording Interval Database File Names

Type of
Statistical
Information

Recording Interval File Name

Real-Time A real-time temporary file in memory

Short Term NT$HIST0.NTD

Long Term NT$HIST1.NTD

Maximum Size

The Maximum Size field is shown in bytes. This field is based upon a pre-calculated
file size that is derived from the specified Recording Interval and Recording
Duration times. If you change the Recording Interval or Recording Duration time for
Real-Time, Short, or Long Term data collecting, the Maximum Size field will
automatically recalculate. A new allocated Maximum Size value for that collection
period will then be displayed.

Current Size

The Current Size field (Figure 9.72) is shown in bytes, and is the Recording Interval
database file’s current size. The Current Size field tells you how much disk space
your current Recording Interval database file is occupying.

When recording interval database files reach maximum size, NetTune automatically
begins purging the oldest data from the files. This built-in purging function prevents
database files from exceeding maximum specified sizes.
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Returning Recording Interval and Duration to Default Values

To change Recording Interval and Duration back to default values:

1. Select the desired server from the Server’s list box.

2. Click on the Default command button.

3. Click on the Close button when finished.

The following table shows the default times for Recording Interval and Recording
Duration.

Default Times for Recording Interval and Recording
Duration

Interval Duration

Real-Time 5 seconds 3 minutes

Short-Term 5 seconds 24 hours

Long term 5 minutes 90 days

Viewing and Printing Statistics

Viewing Statistics in a Graph

To view actual statistics in a graph:

1. Click on the Hot Key icon (Figure 9.3). The cursor will change into a thick
vertical arrow.

Figure 9. 73 - Hot Key Icon

2. Place the arrow cursor over the desired color segment.

3. Click and hold down the left mouse button. This will display the actual numbers
for that region of the graph.
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Viewing Statistics in a Text Report

Graph data can be displayed as an ASCII text report.

To view an ASCII text report:

Click on the Graph/Text icon (Figure 9.4). This will change the Network Statistics
graph into a readable (and printable) text report.

Figure 9. 74 - Graph/Text Icon

Printing Graphs and Reports

Information found in the graphs or text reports can be output to a printer for later
reference.

To print a graph or report:

1. Display the graph or the text report.

2. Select Print from the File pull-down menu.

Optional method:

Click on the printer icon while the graph or report is on the screen.
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Chapter 10 Maps Menu Introduction

NetTune provides you with NLM memory information and how it relates to the total
system’s memory for a file server. This information is obtained through the Maps
menu (Figure 10.75).

Figure 10. 75 - Maps pull-down menu

NLM Memory Command
Use the NLM Memory command to report on NLM file server memory usage
(Figure 10.76).

To view NLM Memory usage data:

Select the Maps Menu and then click on the NLM Memory command.

The command displays all NLMs occupying memory, and how much memory each
segment of an NLM is using.

Figure 10. 76 - NLM Memory Map
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To view specific NLM Memory Information:

1. When the NLM Memory Map displays, NetTune activates the Memory
Information Hot Key.

Position the Hot Key arrow in any NLM memory column segment.

NOTE:

Click on the Toolbar  Hot Key icon (see above) to activate or deactivate the hot
Key feature.

2. Depress and hold down either mouse button to view segment contents and
amount of memory space occupied.

3. Toggle between a graph and text report with the Graph/Text toolbar button.

The NLM Memory Map graph will display LOADER.EXE which is the part of
the NetWare Operating System that communicates with the file server’s
hardware.

Memory Pool Command
The Memory Pool command shows where (in the system’s total segmented memory)
an application, utility, NLM, or data resides (Figure 10.77).

Figure 10. 77 - Memory Pool Map
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To select view the Memory Pool graph:

Select the Maps Menu and click on the Memory Pool command.

Figure .78 - Maps Pull-Down Menu, Memory Pool Command

This graph displays how much memory an application or NLM is using, and where
in the system’s total memory that application or NLM is residing. This data can be
used to decide which of the NLMs to unload if system memory becomes limited.

To view Memory Pool Map data:

1. When the Memory Pool Map displays, NetTune activates the Memory
Information Hot Key.

NOTE:

If NetTune’s cursor does not change, click on the toolbar Hot Key icon to activate
the Hot Key feature.

2. Position the Hot Key arrow in any segment of the NLM memory map.

3. Depress and hold down any mouse button to view segment contents and amount
of memory space occupied.

4. Toggle between graph and text report with the Graph/Text toolbar button.
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NOTES
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Chapter 11 Tools Menu Introduction

The Tools menu provides you with the following options:

• NLM Install

• RCONSOLE

Figure 11. 79 - Tools Pull-Down Menu

NLM Install Command
The NLM Install option is used to install the NetTune NLMs on a file server.

 NLMs Installed on the File Server

NetTune ships with five NLMs and two NCF files:

• NET31X.NLM - The NetWare 3.1X data collection module.

• NETTUNE.NLM - Contains the engine for collecting the historical database
information.

• DPATCH.NLM - This disk statistics v1.00 patch contains the Novell fix to
NetWare version 3.11 (only required if you are running NetWare version 3.11).
When used, it allows statistical disk information to be collected.

• SMARTUNE.NLM - contains the engine for performing the following tasks:

 - Manually modifying Set parameters

 - Editing NCF Files

 - Automatic Tuning

 - Scheduling Tune files
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• NETCONVRT.NLM - Converts database files from the 1.2 format.

• TUNE.NCF - NetWare NCF file used to load the NLMs.

• UNTUNE.NCF - NetWare NCF file used to unload the NLMs.

 Tools Menu Install Procedure

To Install NetTune on a file server:

NOTE:  NetTune automatically loads the NLMs into the SYSTEM directory of the
file server’s SYS: volume.

Select NLM Install from Tools menu bar.

1. NetTune’s NLM install dialog will appear (Figure 11.15) Under the Show
Servers’ selection box you will see three options:

2. Not Running NetTune - Displays all the file servers that currently do not have
NetTune’s NLM loaded.

Running an Old Version of NetTune - Displays all the file servers that currently
have an older version NetTune’s NLM loaded.

ALL - This displays all the file servers without regard to the NetTune version.

Figure 11. 80 - NetTune NLM Install Dialog Box

Since this is a first time install, select the Not Running NetTune button. A list of
file servers not currently installed with NetTune is displayed in the Server box.

3. Select the file server(s) to be loaded with NLM software and click on the left
mouse button once. The Installation program allows you to make multiple file
server selections.

4. After making a server selection, click on the Install button.

During the NLM install process an installation meter will display the percentage
completed.
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 Windows for WorkGroups Note:

If you do not see any file servers listed in the Servers’ box, Windows for
WorkGroups may not be set up for network use. To select an appropriate
network:

Double click on the network setup icon (from the Network group window).

Next click on the Network button.

A dialog box will appear, select “Install Windows support for the following
network only.”

Next click on the  scroll bar to open the Network selection window.

Now use the scroll bar to select the appropriate NetWare version.

When finished, click the OK button twice to save your settings.

Windows 3.1 Note:

If you do not see any file servers listed in the Servers box this could mean your
Windows 3.1 is not set up for network use. To select an appropriate network:

Select the Windows Setup icon from the Main window.

Select Change System Settings from the Options pull down menu.

Click on the Network button and select the appropriate NetWare.

When the NLM installation has completed the RCONSOLE request dialog box
will appear (Figure 11.16).

Figure 11. 81 - RCONSOLE Request Dialog Box

5. Click on the Yes button.

Selecting Yes, causes NetTune to automatically load Novell’s RCONSOLE.
This provides you with a user interface for loading NETUNE.
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RCONSOLE could fail to load for one of the following reasons:

• Not having console rights to that file server. Check that you are logged in as
SUPERVISOR or that you have console rights as a user.

• Not enough memory available. Try freeing up some resources to release
additional memory.

• The RCONSOLE.PIF contains the wrong path. Make sure the program
information file has the correct path to RCONSOLE.

6. When the file server prompt appears, load the NetTune module by typing the
following NCF file name: TUNE

NOTE:  The TUNE.NCF file automatically loads SMARTUNE.NLM in
read/write mode but with timing disabled. To disable the write mode, edit the
TUNE.NCF file and remove the “W” option.

You have now completed Quick Start’s NLM install portion for your file server.

If you installed the NLMs to more than one server, it will be necessary to
connect to each server through RCONSOLE and run the TUNE.NCF file. When
completed, exit RCONSOLE with the <Shift -Esc> key combination.

 NLM Dependencies

NetTune depends on other NLM’s. When TUNE.NCF is executed at the file server,
dependent NLM’s are automatically loaded. This eliminates the manual loading of
NLMs from the server’s console.

The UNTUNE.NCF file automatically unloads the NLMs in the reverse order that
they were loaded.

To automate the task of loading NetTune, place the load command at the bottom of
your AUTOEXEC.NCF file.
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RCONSOLE Command
The RCONSOLE option automatically loads Novell’s RCONSOLE. The remote
console can be used as a virtual file server console to load and unload NLMs from
inside the NetTune application (Figure 11.6).

Figure 11. 82 - Novell’s RCONSOLE Utility

If you have a problem loading RCONSOLE, from NetTune, check that you have
console rights.

To exit RCONSOLE:

1. Pressing the <SHIFT> <Esc> keys at the same time.

2. Answer Yes to the question “Do you want to quit RCONSOLE?,” and press the
<Enter> key.
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Chapter 12 Options Menu Introduction

To select the Options menu, click on Options in NetTune’s Menu Bar.

Figure 12. 83 - Options Pull-Down Menu

This chapter describes the available Option commands.

Save Settings  on Exit Command
To save the NetTune desktop when quitting NetTune, choose the Save Settings on
Exit command from the options menu (Figure 12.83). A check mark next to the
command means it is in effect.

By default, NetTune saves the desktop in the NETTUNE.INI file. When the NetTune
program is started, NETTUNE.INI  is used to restore the desktop.

You can create additional custom desktop INI files for NetTune containing other
desktop settings.

To open a custom desktop INI file:

1. From NetTune, press ALT+TAB and switch to the Windows Desktop.

2. Click once on NetTune’s icon from the Windows Program Manager desktop.

3. Select the File pull-down menu from the Windows Program Manager menu bar.

Select Properties from the File pull-down menu.
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Go to the Command Line field in the Program Item Properties dialog box. At
the end of the path string for NetTune, insert a space and enter the desired
substitute INI file name (Figure 12.84).

The next time you enter NetTune, the desktop will use the new INI file you
entered.

Figure 12. 84 - Entering a Custom INI File

To undo the Save Settings On Exit command:

Select Save Settings On Exit from the Options pull-down menu. This action
removes the check mark, which means the command is no longer in effect.

Group Management Command

To Add a New Server Group to the NetTune Desktop

To organize and manage the NetTune desktop, you can arrange servers into groups.

To create a new server group:

1. Select Group Management from the Options pull-down menu (Figure 12.85).

Figure 12. 85 - Options Pull-Down Menu
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2. Next, click on the New button in the Group Management dialog box (Figure
12.86).

Figure 12. 86 - Group Management Dialog Box

3. Next, click on the name field in the Group Management Name dialog box
(Figure 12. 87), and enter a descriptive group name.

4. As an example, type the name “TEST GROUP” in the Name field (Figure
12.87), and click on the OK button to save the new group.

Figure 12. 87 - Group Management Name Dialog Box

The newly created group name now appears in the Group Management dialog
box (Figure 12.88).

NOTE:

NetTune limits for Groups and Servers per Group.

255 Groups

255 Servers per Group
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Figure 12. 88 - Group Management Dialog Box

5. In the Servers’ selection box, highlight the name(s) of all servers you want to
add to the newly formed group and click on the Add button (Figure 12.89).

Figure 12.89 - Adding a file server to the TEST GROUP

6. Click on the Close button to save your work.

The TEST GROUP icon now appears on NetTune’s desktop (Figure 12.90).

Figure 12. 90 - TEST GROUP Icon
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To Delete a Server/Group from the NetTune Desktop

1. First, highlight the server/group in the Group/Servers’ selection box (Figure
12.91) and click on the Delete button.

Figure 12. 91 - Highlighting a file server to delete from Desktop

2. After the decision dialog box appears (Figure 12.92), click on the Yes button to
delete the group/server from the NetTune Desktop.

Figure 12. 92 - Decision Dialog Box

3. Click on the Close button to exit the Group Management dialog box.
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Group Management Dialog Box Command Buttons

The following table identifies and describes all command buttons found in the
Group Management dialog box.

Push
Button

Description

ADD The Add button will add the highlighted
selected server(s) to a selected group.

ADD
ALL

The Add All button will add all NetTune
servers to a selected group.

CLOSE The Close button will end the session and
exit from the Group Management dialog
box.

HELP The Help button will bring up NetTune
Help index.

SHOW The Show button will display all server
and group icons on NetTune’s desktop.

HIDE The Hide button will hide all server and
group icons from displaying on NetTune’s
desktop.

DELETE The Delete button will delete a highlighted
server or group from a selected group.

NEW The NEW button will create a new group
in the Groups/Servers’ selection box.

RENAME The Rename button will rename any
selected group.
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Login Command
When the Login command is selected from the Options’ menu, the Login dialog box
appears (Figure 12.93).

Figure 12. 93 - Login Dialog Box

To modify data on a file server, you may be required to login to gain console rights.

NOTE:  If you get the “Invalid login!” message while attempting to login, your ID
or password is invalid, or no additional connections are available on the server.

To log on to a file server:

1. Select Login from the Options pull-down (Figure 12.85) menu.

2. Enter an ID in the User ID text box.

3. Enter a password in the Password text box.

4. Click on the Login button.

NOTE:  Logging into a File Server may change your access rights or drive
mappings.

Logout Command
When the Logout command is selected from the Options’ menu, the Logout dialog
box appears (Figure 12.94).

12.94 - Logout Dialog Box

The Logout dialog box is used to break the current workstation to file server
connection.
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To log out of a file server:

1. Select Logout from the Options pull-down (Figure 12.85) menu.

2. Click on the Logout command button in the Logout dialog box.

Login Status Command
When the Login Status command is selected from the Options’ menu, the Login
Status dialog box appears (Figure 12.95).

12.95 - Login Status Dialog Box

This dialog box is used to enable or disable logins to the file server. If disabled,
users will be unable to login to the server. The default for Login Status is Enabled.

To disable logins:

1. Select Login Status from the Options pull-down (Figure 12.85) menu.

2. Click on the Logins Enabled check box.

3. Click on the OK button for the action to take affect.

NOTE:  Before exiting this dialog box, make sure you desire to disable logins to the
file server.

Down Server Command
It is necessary to occasionally down a file server for maintenance. The Down Server
dialog box is used to gracefully down a file server (Figure 12.96).

NOTE:  Scheduled shutdowns are the most desirable. Downing a file server "cold"
guarantees damage to user files. This command should be executed only after all
users have logged off the server.

Warn all users before shutting down a file server.
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Figure 12. 96 - Down Server Dialog Box

You must have Supervisory rights in order to down a file server with the Down
Server command. After downing the server, NetTune automatically hides the server
icon.

To display the server icon:

1. Select Group Maintenance from the Options pull-down (Figure 12.85) menu.

2. Select the server and click on Show command button. If the server does not
show, then the NetTune NLMs are not running or the server is down.

Toolbar Command
The Toolbar at the top of NetTune’s desktop is displayed by default. A check mark
next to the command means it is in effect.

Figure 12. 97 - Toolbar Command

NetTune Toolbar

The Toolbar is a graphical bar with command buttons that perform some of the most
common commands in NetTune (Figure 12.98).

Figure 12. 98 - NetTune Toolbar
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To use the Toolbar:

Click on the icon you want execute.

 NetTune Toolbar Icons

The following table contains Toolbar icon names and descriptions.

Toolbar
Icon

Name Action

Save Save the current file.

Cut Cut the selected block and place it
on the clipboard.

Copy Copy the selected block to the
clipboard.

Paste Insert a copy of the clipboard
contents.

Customize
Report

Select Date and Time interval and
Report type.

Increase
Time
Interval

Increase the time interval of the
data currently being viewed.

Graph
Data\Text
Data

Toggle between a graph or ASCII
text report.
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Graph
Options

Open the graph options dialog box
to select a graphing option.

HOT KEY Toggle the Hot key On or Off.
The Hot feature is On when the
cursor arrow is thick.
NOTE:
This feature consumes memory.

Increase
Data Points

Increase the data points on a
graph.

NetTune
Advisor

On-line Help Utility

Help Display Help information.

Context
Sensitive
Help

Context sensitive help that
displays only the help information
selected by the mouse.



176 Using NetTune

Status Bar Command
The Status Bar at the bottom of NetTune’s desktop is displayed by default. A check
mark next to the command means it is in effect.

Figure 12. 99 - Status Bar Command

The Status bar provides the following information:

• Help key identification

• The file server’s name

• The file server’s NetWare version

• The user’s name

• Information on the keyboard’s lock status

To hide the Status Bar:

1. Choose the Options Menu.

Click on the Status Bar Command.
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Chapter 13 Window Menu Introduction

The Window menu is located on the right side of the Menu Bar at the top of the
NetTune Window (Figure 13.1). The commands in this menu allow you to control
the display of application windows. A number of optional commands are available
in the pull-down menu.

To open the pull-down command menu, position the mouse cursor over the Window
menu, and then click the left mouse button.

Figure 13. 1 - Window Menu Pull-Down Commands
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Cascade Command
The Cascade command is used to arrange all open application windows so that they
are visible in the NetTune window (Figure 13.2). The command causes the windows
to overlap so that each open application title bar is visible.

Figure 13. 2 - Cascading Application Windows
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Tile Vertical Command
The Tile Vertical command is used to arrange all open application windows so that
they are visible in the NetTune window (Figure 13.3) The command causes the
windows to vertically stack so that each open application window is visible.

Figure 13. 3 - Vertical Window Tiles
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Tile Horizontal Command
The Tile Horizontal command is used to arrange all open application windows so
that they are visible in the NetTune window (Figure 13.4). The command causes the
windows to horizontally stack so that each open application window is visible.

Figure 13. 4 - Horizontal Window Tiles
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Arrange Icons Command
The Arrange Icons command is used to organize all scattered icons (Figure 13.5).
The command causes the icons to align at the bottom of the NetTune window so that
each icon is visible.

Figure 13. 5 - Arranged Icons
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Application Window Command
NetTune will permit you to have several windows and icons open simultaneously.
The Window command displays these at the bottom of the cascading menu (Figure
13.6). To select the window you want, simply click on the name.

Figure 13. 6 - Application Window Commands

If more windows are open than can be displayed in the cascading menu, the
command “More Windows...” appears at the bottom of the Window menu. Click on
the More Windows command to open the Select Window dialog box.
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The Select Window dialog box is used to view a list of all windows (Figure 13.7).
Click on the window you desire to activate.

Figure 13. 7 - Select Window Dialog Box
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Chapter 14 Help Menu Introduction

The Help Menu
NetTune is equipped with a built-in Help utility that can assist you in using
NetTune. The Help pull-down menu (Figure 14.8) is located on the top right side of
NetTune’s Menu Bar.

Figure 14. 8 - NetTune’s Help Pull-Down Menu

Selecting the Help menu allows you to:

• Access the Help Index for NetTune. The Help Index is the table of contents for
NetTune commands and concepts.

• Access the Using Help utility. The Using Help utility brings up a table of
contents of all the concepts related to using Window’s help.

• Access the Quick Start dialog box for additional configuration changes.

• View the About NetTune dialog box.
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Index Command

Figure 14. 9 - Index Command

The Index command opens NetTune’s Help Index window (Figure 14.10). The on-
line Help Index contains important information about the following NetTune
information:

• On-line Help manual

• Server statistics reference

• NetTune menu descriptions

• HawkNet information and technical support

Using Help Command

Figure 14. 10 - Using Help Command

The Using Help command opens the How to Use Help window (Figure 14.11). If
you have not learned how to use Window’s Help, you can use the on-line help to get
information regarding any Help command.
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Figure 14. 11 - Using Help Command

NetTune Quick Start Command

Figure 14. 12 - NetTune Quick Start Command

The Quick Start command allows you to install NLMs, view a server’s
configuration, set up Recording Intervals, and create Groups for NetTune’s desktop
(Figure 14.12). For more information on this command read Chapter 3 Quick Start.
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NetReport Advisor Command

Figure 14. 13 - NetTune Advisor

The NetReport Advisor is an on-line Help utility that can is located on NetReport’s
tool bar (Figure 12.), or in the Help pull-down menu.

About NetTune Command

Figure 14. 14 - About NetTune

The About NetTune command brings up the About dialog box containing
information about the NetTune program (Figure 14.15).

The About dialog box displays:

• The NetTune Icon

• Version of program

• Copyright information

• The NETX VIPX and IPX program versions

• Amount of available system resources and memory
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Figure 14. 15 - About NetTune Dialog Box

The Help Icons
Along with NetTune’s Help menu, NetTune also provides help through its Help
icons. The Help icons can be found on the right side of the Toolbar (Figure 14.16).
These icons provide you with fast access to either the Help Index or the Context
Sensitive Help.

Figure 14. 16 - NetTune’s Toolbar

You can bring up the Help Index by clicking on the Help Index icon (Figure 14.17).
Position the mouse cursor over the Help Index icon and click the mouse button.

Figure 14. 17 - Help Index Icon

NetTune also includes context sensitive help, which allows you to quickly locate
information on specific topics. The context sensitive help can be identified by the
Context Sensitive Help icon (Figure 14.18). It is located on the right side of the
Toolbar.

Figure 14. 18 - Context Sensitive Help Icon
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To get Context Sensitive Help on a specific topic:

1. Click on the Toolbar Context Sensitive Help icon (Figure 14.18).

2. From NetTune’s Menu bar, click on any menu item. This will bring up context
sensitive help for that specific topic.

Printing Help Topics
There are two ways to print Help topics.

• The NetTune Help Utility

• The Context Sensitive Help icon

Printing Help Topics using the NetTune Help Utility

One way to print help topics is to use NetTune's Help utility.

1. From NetTune’s Menu bar select Help.

2. Click on the Index command (Figure 14.19) to open the NetTune’s Help Index
screen.

Figure 14. 19 - Printing Help Topics

3. Position the mouse pointer over the topic you desire to print.

Click the mouse button to display the Help topic.

NOTE:  The mouse pointer will change into a hand as it scans the hyper-
sensitive topics.

3. Next, go to NetTune’s Help menu bar and select File.

4. Finally, click on Print Topic to start printing the selected topic.
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Printing Help Topics through NetTune

Help topics can also be printed by using the Context Sensitive Help icon located on
NetTune’s Toolbar.

1. Select the Context Sensitive Help icon (see figure 14.18) from the Toolbar by
double clicking on the icon with the mouse button.

NOTE:  The mouse cursor will change to an arrow in the shape of a question
mark.

2. Use the question mark cursor to scan through NetTune’s Menu bar. When you
observe a menu topic of interest, double click the left mouse button to open the
Help screen.

3. After the Help screen appears, go to NetTune’s Menu bar and select File.

4. Click on Print Topic to send the context sensitive help information to the
printer.
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Appendix A Error Messages

This appendix helps you troubleshoot problems associated with:

• Startup error messages

• Server error messages

• Windows error messages

Startup Error Messages

“Network Error XXXX VIPX.386 is not loaded!
VIPX.386 VX.X is not compatible!
Network Error XXXX Opening NetTune Socket!“

These errors occur when you attempt to run outdated or incompatible window
network drivers. NetTune takes advantage of bug fixes and enhancements in the
latest Novell network window drivers. The latest versions of these NetWare drivers
can be obtained from the McAfee BBS.

If any of these error messages appear, check the list below.

• Check that your workstation is running on DOS version 5.0 of higher.

• Check that WINDOWS is version 3.1 or higher.

• Check that WINDOWS is running in 386 Enhanced mode.

• Check that all your Network shells are current.
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• Check that your SYSTEM.INI file has the line:

Network=...,VIPX.386

• Check that the VIPX.386 is version 1.17 or later.

• Use only the NWCALLS.DLL and NWIPXSPX.DLL that ship with NetTune.

If you try all the above suggestions and you still need assistance, report the XXXX
error number to McAfee Technical Support.

“Unable to initialize network!”

This message displays if one of the above-mentioned conditions are encountered
while exiting NetTune.

Server Related Errors

“The NetTune NLM running on this server is not compatible
with this version of the  NetTune windows application. Please
upgrade your NetTune NLMs.”

This message appears when the NetTune NLMs were not upgraded from an older
version. You must upgrade the NLMs to version 2.1.

“The NetTune NLM was loaded in read-only mode. The
requested change was not made.”

The NLM was loaded without the "W" option. Unload and reload the NLM with the
"W" option.

 “Error encountered during detachment from server.”

Netware is unable to disconnect, either the connection has been lost, or the server is
down.

“The NetTune NLM did not respond!”

The NetTune NLM is not responding. It may have been unloaded, or the path to
server is no longer available. All server objects will be removed.
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“Error encountered during attachment to server.”

The file server is out of connections, or a NetWare error occurred. Close and reopen
the server to reinitialize the connection.

“Invalid Login!”

This message occurs when either an invalid password has been entered, or the
connection to the server is no longer valid. Close and reopen the server to reinitialize
the connection.

 “The selected NCF file does not exist!”

The NetTune NLM could not find the NCF file on the server C: or A: drive, or in the
SYS:\SYSTEM directory.

Windows Related Errors

“Windows timer limit exceeded! A timer resource was not
available for this real-time report.”

Windows only allows a total of 32 timers. Other applications may be using timers.
Close unused real-time Windows.

NOTE:  Timers are a Windows’ resource. The timer allows Windows to update the
real-time graph when the specified time interval has lapsed.

“Error Opening Export File!”

This message displays when either the volume is out of disk space, or the directory
does not exist.

 “Unable to kill real-time timer.”

This error indicates a possible low memory condition. Check the amount of free
memory and system resources. Keep as much free memory open as practical.
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Appendix B Troubleshooting

NetTune Installation and Operation Problems
If you encounter the error message, "Can't initialize the Network," check the
following:

• Workstation is running DOS version 5.0 or higher.

• Windows is running version 3.1 or higher and is in the 386 Enhanced mode.

• Windows is setup for a Network.

• Network shells are current.

• • The SYSTEM.INI file must contain the following line:

Network=...,VIPX.386

NOTE:  The dots represent other possible arguments the network command might
be using.

Information for Windows for WorkGroups Users
If you do not observe any file servers listed in the “Servers” box, Windows for
WorkGroups is not set up for Network use.

To select an appropriate network:

1. Double click on the Network setup icon (from the Network group window).

2. Next, click on the Network button.

3. In the dialog box, select “Install Windows support for the following network
only.”
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4. Next, click on the  scroll bar to open the Network selection window.

5. Use the scroll bar to select the appropriate NetWare version.

6. When you have finished, click on the OK button twice to save your settings.

Special Note about Windows 3.1
If you do not see any file servers listed in the “Servers” box, this could mean your
Windows 3.1 is not set up for Network use.

To select an appropriate network:

1. Select the Windows Setup icon from the Main window.

2. Select Change System Settings from the Options pull down menu.

3. Click on the Networks button and select the appropriate NetWare.

Upgrading NetTune NLMs
Before you install any new NetTune NLMs, remove all older versions. This can be
accomplished from the file server’s console, or by launching RCONSOLE.EXE from
the NetTune application.

NetWare 3.11
The DPATCH.NLM is not required. However, if it’s not loaded, NetTune's Disk
Activity will always report zero.
NET31X.NLM automatically loads DPATCH.NLM, then DPATCH.NLM
automatically loads PATCHMAN.NLM.
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RCONSOLE Fails to Load
If RCONSOLE fails to load, check the following:

• Console rights to that file server.
You must either login as SUPERVISOR, or have console rights as a user.

• Not enough memory available.
Free up some resources to make more memory available.

• The RCONSOLE.PIF contains the wrong path.
Make sure the program information file (RCONSOLE.PIF) has the correct path
to RCONSOLE.

Backing Up Historical Database Files
If you experience problems backing up your historical database files while the
NetTune NLMs are loaded, use the NetWare flag utility to mark the database files as
Shareable.

flag +s *.ntd

DLL Files Not Found while running Windows on the
Network

NetTune looks locally for the Windows’ directory. This is where NetTune expects to
find its DLL files. If your Windows is located on the network, copy the DLL files in
the NetTune directory to the network Windows directory.

Release Notes
For additional release notes on NetTune, click on the NetTune ReadMe icon in the
HawkNet Window Group, or use a text editor to open the README.WRI file on
the installation disk.
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Appendix C NetTune Set Parameters Quick Reference

The following NetWare version 3.11 and 3.12 SET parameters are supported by
NetTune.

Parameters are listed alphabetically by name and default value. Also included are
range limit(s), a brief parameter description, and special notes.

Parameters

Allow Change To Client Rights = ON

Limits: ON, OFF

Description: Allows the client rights to be changed.

Notes: This parameter is for version 3.12 only. It
can be found under Tune\Set
Parameters\Miscellaneous.

Allow LIP = ON

Limits: ON, OFF

Description: Allow Large Internet Packet support.

Notes: This parameter is for version 3.12 only. It
can be found under Tune\SetParameters\
Communications.
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Allow Unencrypted Passwords = OFF

Limits: ON, OFF

Description: Allow unencrypted password requests to be
used.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Auto Register Memory Above 16 Megabytes = ON

Limits: ON, OFF

Description: Automatically add memory which can
be detected above 16 megabytes on
EISA bus machines.

Notes: This command is for version 3.11 only.
Can be found under Tune\Set
Parameters\Memory.

Auto TTS Backout Flag = OFF

Limits: ON, OFF

Description: Automatically does TTS backouts
during a re-boot (It will skip the
prompts).

Notes: Can be found under Tune\Set
Parameters\Transaction Tracking.
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Cache Buffer Size = 4096

Limits: 4096 to 16384

Description: Size of file cache buffers.

Notes: Can be found under Tune\Set
Parameters\Memory.

Concurrent Mirror Requests = 4

Limits: 2 to 30

Description: Set the number of remirror requests per
logical partition.

Notes: This parameter is for version 3.12 only.
It can be found under Tune\Set
Parameters\Disk.

Console Display Watchdog Logouts = OFF

Limits: ON, OFF

Description: Display on the console watchdog
connection failure logouts.

Notes: Can be found under Tune\Set
Parameters\Communications.



204 Using NetTune

Delay Before First Watchdog Packet = 4 min. 56.6 sec.

Limits: 15.7 seconds to 20 minutes 52.3
seconds

Description: Amount of time the server will wait,
without receiving a request from a
workstation, before asking the
workstation if it is still attached to the
file server.

Notes: Can be found under Tune\Set
Parameters\Communications.

Delay Between Watchdog Packets = 59.3

Limits: 9.9 seconds to 10 minutes 26.1 seconds

Description: Amount of time the server will wait for
an inactive workstation to reply to a
watchdog packet, before asking the
workstation again if it is still attached
to the file server.

Notes: Can be found under Tune\Set
Parameters\Communications.

Directory Cache Allocation Wait Time = 2.2

Limits: 0.5 seconds to 2 minutes

Description: Minimum time to wait between new
directory cache buffer allocations.

Notes: Can be found under Tune\Set
Parameters\Directory Caching.
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Directory Cache Buffer NonReferenced Delay = 5.5

Limits: 1 second to 5 minutes

Description: Normal time to wait after a directory
cache buffer was referenced before re-
using it.

Notes: Can be found under Tune\Set
Parameters\Directory Caching.

Dirty Directory Cache Delay Time = 0.5

Limits: 0 seconds to 10 seconds

Description: Minimum time the system waits before
writing a dirty directory cache buffer.

Notes: Can be found under Tune\Set
Parameters\Directory Caching.

Dirty Disk Cache Delay Time = 3.3 seconds

Limits: 0.1 seconds to 10 seconds

Description: Minimum amount of time the system
waits before writing a not completely
dirty disk cache buffer.

Notes: Can be found under Tune\Set
Parameters\File Caching.
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Display Disk Device Alerts = OFF

Limits: ON, OFF

Description: Displays alert messages when a disk
device is added, deleted, mounted,
activated, deactivated, etc.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Display Incomplete IPX Packet Alerts = ON

Limits: ON, OFF

Description: Displays alert messages when IPX
receives incomplete packets.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Display Lost Interrupt Alerts = ON

Limits: ON, OFF

Description: Displays alert messages when the
interrupt controller detects a lost
hardware interrupt.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.
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Display Old API Names = OFF

Limits: ON, OFF

Description: Displays the names of old API routines
that a module is using when the module
is loaded.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Display Relinquish Control Alerts = OFF

Limits: ON, OFF

Description: Displays alert messages when a process
does not relinquish control frequently.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Display Spurious Interrupt Alerts = ON

Limits: ON, OFF

Description: Displays alert messages when a
spurious hardware interrupt is detected.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.
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Enable Disk Read After Write Verify = ON

Limits: ON, OFF

Description: Re-read all data written to disk and
verify correctness.

Notes: Can be found underTune\Set
Parameters\Disk.

Enable IPX Checksums = 1

Limits: 0 to 2

Description: Enables checksum of IPX packets
(0 = no check sums, 1 = check sum if
enabled at the client, 2 = requires check
summing).

Notes: This parameter is for version 3.12 only.
It can be found under Tune\Set
Parameters\Communications.

Enable Packet Burst Statistics Screen = OFF

Limits: ON, OFF

Description: Displays NCP packet burst statistics
screen.

Notes: This parameter is for version 3.12 only.
It can be found under Tune\Set
Parameters\Communications.
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File Delete Wait Time = 5 minutes 29.6 seconds

Limits: 0 seconds to 7 days

Description: Normal time to wait after a file is
deleted before purging it.

Notes: Can be found underTune\Set
Parameters\File System.

Immediate Purge Of Deleted Files = OFF

Limits: ON, OFF

Description: Purge all files immediately upon
deletion.

Notes: Can be found under Tune\Set
Parameters\File System.

Maximum Alloc Short Term Memory = 2097152 < Default setting for
version 3.11>
or
Maximum Alloc Short Term Memory = 8388608 <Default setting for
version 3.12>

Limits: 50000 to 16777216 <version 3.11>,
50000 to 33554432 <version 3.12>

Description: Maximum amount of memory available
to the work dynamic memory pool.

Notes: Can be found under Tune\Set
Parameters\Memory.
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Maximum Concurrent Directory Cache Writes = 10

Limits: 5 to 50

Description: Maximum number of concurrent writes
of directory cache buffers.

Notes: Can be found under Tune\Set
Parameters\Directory Caching.

Maximum Concurrent Disk Cache Writes = 50

Limits: 10 to 100 <version 3.11>,:10 to 1000
<version 3.12>

Description: Maximum number of concurrent writes
of dirty disk cache buffers.

Notes: Can be found under Tune\Set
Parameters\File Caching.

Maximum Directory Cache Buffers = 500

Limits: 20 to 4000

Description: Maximum number of directory cache
buffers that can be allocated by the
system.

Notes: Can be found under Tune\Set
Parameters\Directory System.
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Maximum Extended Attributes per File or Path = 32 <Default setting
for version 3.11>
or
Maximum Extended Attributes per File or Path = 8<Default setting for
version 3.12>

Limits: 4 to 512

Description: The allowable number of extended
attributes for files or paths.

Notes: Can be found under Tune\Set
Parameters\Directory Caching.

Maximum File Locks = 10000

Limits: 100 to 100000

Description: System wide maximum number of file
locks permitted (including open files).

Notes: Can be found under Tune\Set
Parameters\Locks.

Maximum File Locks Per Connection = 250

Limits: 10 to 1000

Description: The maximum number of file locks per
connection permitted (including open
files).

Notes: Can be found under Tune\Set
Parameters\Locks.
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Maximum Outstanding NCP Searches = 51

Limits: 10 to 1000

Description: The maximum number of simultaneous
NCP directory searches that a
connection can have.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Maximum Packet Receive Buffers = 100 <Default setting for version
3.11>
or
Maximum Packet Receive Buffers = 400 <Default setting for version
3.12>

Limits: 50 to 2000

Description: Maximum number of packet receive
buffers that can be allocated by the
server.

Notes: Can be found under Tune\Set
Parameters\Communications

Maximum Percent of Volume Space allowed for Extended
Attributes = 10

Limits: 5 to 50

Description: Percent of volume space allowed for
Extended Attributes storage.

Notes: Can be found underTune\Set
Parameters\File System.
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Maximum Percent of Volume Used By Directory = 13

Limits: 5 to 50

Description: The maximum percent of each volume
that can be allocated for the directory.

Notes: Can be found under Tune\Set
Parameters\File System.

Maximum Physical Receive Packet Size = 1130 <Default setting for
version 3.11 >
or
Maximum Physical Receive Packet Size = 1514 <Default setting for
version 3.12>

Limits: 618 to 4202 <version 3.11>, 618 to
24682 <version 3.12>

Description: Size of the largest packet that can be
received by an MLID.

Notes: Can be found under Tune\Set
Parameters\Communications.

Maximum Record Locks = 20000

Limits: 100 to 200000

Description: System wide maximum number of
record locks (physical, logical &
semaphores).

Notes: Can be found under Tune\Set
Parameters\Locks.
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Maximum Record Locks Per Connection = 500

Limits: 10 to 10000

Description: Maximum number of record locks per
connection (physical, logical &
Semaphores).

Notes: Can be found under Tune\Set
Parameters\Locks.

Maximum Service Processes = 20

Limits: 5 to 40

Description: Maximum number of request servicing
processes.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Maximum Subdirectory Tree Depth = 25

Limits: 10 to 100

Description: Maximum depth of subdirectories.

Notes: Can be found under Tune\Set
Parameters\File System.
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Maximum Transactions = 10000

Limits: 100 to 10000

Description: System wide maximum number of
concurrent transactions.

Notes: Can be found under Tune\Set
Parameters\Transaction Tracking.

Minimum Directory Cache Buffers = 20

Limits: 10 to 2000

Description: Minimum number of directory cache
buffers to be allocated by the server
before delaying.

Notes: Can be found under Tune\Set
Parameters\Directory Caching.

Minimum File Cache Buffers = 20

Limits: 20 to 1000

Description: Number of file cache buffers to be left
by the server (not allocated for other
uses).

Notes: Can be found under Tune\Set
Parameters\File Caching.
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Minimum File Cache Buffer Report Threshold = 20

Limits: 0 to 1000

Description: How close the number of cache buffers
has to get to the minimum before a
warning is issued.

Notes: Can be found under Tune\Set
Parameters\File Caching.

Minimum File Delete Wait Time = 1 minute 5.9 seconds

Limits: 0 seconds to 7 days

Description: Minimum time to wait after a file is
deleted before purging it.

Notes: Can be found under Tune\Set
Parameters\File System.

Minimum Packet Receive Buffers = 100

Limits: 10 to 1000

Description: Minimum number of packet receive
buffers allocated by the server.

Notes: Can be found in Tune\Set
Parameters\Communications.
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NCP Packet Signature Option = 1

Limits: 0 to 3

Description: Options to control NCP Packet
Signatures ( 0 = Don't do packet
signatures - 1 = Do packet signatures
only if client requires them - 2 = Do
packet signatures if the client can, but
don't require them if the client doesn't
support them -3 = Require packet
signatures).
After startup time you can only increase
the level.

Notes: This parameter is for version 3.12 only.
It can be found under Tune\Set
Parameters\Communications.

NCP File Commit = ON

Limits: ON, OFF

Description: Allows applications to flush all
pending file writes to the disk.

Notes: Can be found under Tune\Set
Parameters\File System.

New Packet Receive Buffer Wait Time = 0.1

Limits: 0.1 seconds to 20 seconds

Description: Minimum time to wait before
allocating a new packet receive buffer.

Notes: Can be found under Tune\Set
Parameters\Communications.
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New Service Process Wait Time = 2.2 seconds

Limits: 0.3 seconds to 20 seconds

Description: Minimum time to wait before creating a
new request servicing process.

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.

Number of Watchdog Packets = 10

Limits: 5 to 100

Description: The number of times the file server
will ask an inactive workstation if it is
still attached to the server before
terminating the workstation's
connection if no response has been
received.

Notes: Can be found under Tune\Set
Parameters\Communications.

Pseudo Preemption Time = 2000

Limits: 1000 to 10000

Description: The amount of time (in .84
microsecond increments) to allow
NLMs a process to run without
relinquishing before forcing a
relinquish on the next file read or
write system call (Pseudo Preemption
is enabled on a per NLM basis)

Notes: Can be found under Tune\Set
Parameters\Miscellaneous.
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Read Ahead Enabled = ON

Limits: ON, OFF

Description: As long as sequential file access is
occurring, do background reads to get the
blocks that will be requested soon into
the cache in advance.

Notes: This parameter is for version 3.12 only. It
can be found under Tune\Set
Parameters\File Caching.

Read Ahead LRU Sitting Time Threshold = 10 seconds

Limits: 0 seconds to 1 hour

Description: If the cache LRU sitting time is below
this threshold the read ahead will not
take place.

Notes: This parameter is for version 3.12 only.
It can be found under Tune\Set
Parameters\File Caching.

Replace Console Prompt With Server Name = ON

Limits: ON, OFF

Description: Replaces the console prompt of ":"
with the File server's name.

Notes: This parameter is for version 3.12 only.
It can be found under Tune\Set
Parameters\Miscellaneous.



220 Using NetTune

Reply To Get Nearest Server = ON

Limits: ON, OFF

Description: Causes this server to respond to GET
NEAREST SERVER requests from
workstations that are attempting to
locate a server.

Notes: This parameter is for version 3.11 only.
It can be found under Tune\Set
Parameters\Communications.

Reserved Buffers Below 16 Meg = 16

Limits: 8 to 200 <version 3.11> or 8 to 300
<version 3.12>

Description: Number of file cache buffers to be kept
for device drivers unable to access
memory above 16 megabytes.

Notes: Can be found under Tune\Set
Parameters\File Caching.
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Turbo FAT Re-Use Wait Time = 5 minutes 29.6 seconds

Limits: 0.3 seconds to 1 hour 5 minutes 54.6
seconds

Description: The minimum amount of time to wait
before re-using a closed Turbo FAT.

Notes: Can be found under Tune\Set
Parameters\File System.

TTS Abort Dump Flag = OFF

Limits: ON, OFF

Description: This enables the dumping of data from
aborted transactions to a log file

Notes: Can be found under Tune\Set
Parameters\Transaction Tracking.

TTS Backout File Truncation Wait Time = 59 minutes 19.2 seconds

Limits: 1 minute 5.9 seconds to 1 day 2 hours
21 minutes 51.3 seconds

Description: The minimum time to wait before
truncating the TTS backout file.

Notes: Can be found under Tune\Set
Parameters\Transaction Tracking.
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TTS UnWritten Cache Wait Time = 1 minute 5.9 seconds

Limits: 11 seconds to 10 minutes 59.1 seconds

Description: The maximum time a cache buffer
write can be delayed by the TTS.

Notes: Can be found under Tune\Set
Parameters\Transaction Tracking.

Volume Low Warn All Users = ON

Limits: ON, OFF

Description: Send volume low warning to all users

Notes: Can be found under Tune\Set
Parameters\FileSystem.

Volume Low Warning Reset Threshold = 256

Limits: 0 to 100000

Description: The number of disk blocks that are
above the volume low warning
threshold where the warning trigger is
reset.

Notes: Can be found under Tune\Set
Parameters\File System.
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Volume Low Warning Threshold = 256

Limits: 0 to 1000000

Description: Threshold where a warning is issued
that the volume is getting low on disk
space (number is in disk allocation
units).

Notes: Can be found under Tune\Set
Parameters\File System.
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NOTES
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